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Welcome to MoviePlus X6! 
Welcome to MoviePlus X6, the powerful video-editing program from Serif. 
MoviePlus is the program of choice for video editors looking for easy and 
intuitive ways to create and share their own movies. 

MoviePlus X6 offers an exciting experience at all the key steps of movie 
creation—from importing media, media management (trimming and ordering), 
and video editing, through to exporting your project to DVD and Blu-ray disc. 
You can also share your movie via YouTube and Facebook, as well as use all the 
latest Apple devices. 

Video editing can be performed in storyboard or timeline mode (for ease-of-
use vs. editing power). Whichever mode you plan to work in, you'll be the envy 
of your audience at your movie's first screening! 

Upgrading? 

If you've upgraded from a previous version, this new edition of MoviePlus 
includes a host of exciting new features (p. 10) which keeps MoviePlus ahead 
of its competitors and at a fraction of the price! 

Registration 

Don't forget to register your new copy, using the Registration Wizard on the 
Help menu. That way, we can keep you informed of new developments and 
future upgrades! 
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Key features 

MoviePlus basics 

• Storyboard Simplicity or Timeline Editing Power! 
Use the Storyboard for basic movie projects or "slideshow" image 
montages. Clips are automatically arranged in sequence one-by-one 
with inter-clip transitions. The Timeline lets you arrange video and 
audio clips with editing freedom, working with an unlimited number 
of video and audio tracks (or groups). 

• Easy Project Setup 
From the Startup Wizard and Media pane, importing media options 
(Import from Disk and Copy from Device) offer to set up your 
project according to the chosen media clip's properties. For example, 
import a clip from your HD camcorder, and your project is set up as 
an HD project automatically! 

Gathering and managing media 

• Media Pane 
Your project's media (video, image, and audio files) can be gathered 
together in a Media pane before commitment to your storyboard (or 
timeline). You can reuse media for subsequent projects by adding to 
the pane's Library tab. Fix incorrectly oriented image and video files by 
one-click rotation. 

• Import Media 
Copy from camcorder, USB mass storage devices (hard drive, 
memory stick/card, flash drives), or CD/DVD. MoviePlus transfers 
media files straight from your device, ready for use in your Media 
pane. 

• Trimming and Splitting 
Trim video clips to your preferred length in a dedicated Trimming 
dialog, without affecting your original video clip. Create separate 
trimmed scenes per clip, removing unwanted video or audio content 
with ease. Optionally, just split (cut) your clip up into multiple scenes! 
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Timeline essentials 

• Tracks and Groups 
Store clips across multiple "layered" tracks for stunning blending 
effects (opacity control) or split-screens, spins, rotations, and rolls 
(transform control). Control opacity and transforms at group level 
using video groups (containing multiple video tracks). 

• Clip-based Opacity, Crop, and Transform Control 
Apply opacity, cropping, and transforms to any selected clip! 

• Keyframe Controls 
Transitions, effects, and adjustments (opacity, transform, volume, 
stereo panning, and more) are all "key-framable". You can specify 
changes over time and all the in-between steps are calculated for you. 
The changes themselves can also adopt different speeds or 
accelerations by changing the keyframe properties. 

• Preset Adjustments 
Enjoy a comprehensive range of preset adjustments—these can be 
simply dragged and dropped onto video and audio tracks and will 
perform previously complex video editing techniques, such as opacity, 
transform and crop, with ease. 

• Transparent Overlays 
All of MoviePlus's video tracks support video transparency to 
superimpose not just titles but any 32-bit transparent image (or video) 
over your movie's action. Make portions of existing video transparent 
by adding a mask (as you might in a bitmap-editing program like Serif 
PhotoPlus) or by picking a solid colour to become transparent. Use 
popular Blend Modes to adjust how your layered videos' pixels interact 
with each other. 

• Multiple Picture-in-Picture 
Create professional picture-in-picture effects using video clips or still 
frames by easily editing the size and position of your video in the 
Video Preview pane. Perfect for showing supplemental visuals without 
detracting from the main movie, or tiling multiple videos together for 
a dynamic scene. 
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Audio 

• Narration Recording 
Record voice-overs while you play back your movie—simply set up 
your microphone, press record and begin talking! 

• Digital CD Ripping 
Rip your audio CDs—great for creating movie soundtracks from your 
favourite songs. 

• Dolby® Digital Stereo Support 
For DVD export, MoviePlus now uses Dolby Digital to encode and 
compress audio (leaving more room for video!). Video files with 
Dolby Digital streams can also import without the need for third party 
codecs. 

• On-demand Waveform Generation 
Create waveforms for audio clips from the Media pane or just when 
you need them from the Timeline. Audio waveforms for any audio clip 
help to synchronize audio events. 

• Audio Levels 
Avoid audio distortion with the Levels meter—audio level meters 
indicate if your current audio levels hit the Red. Use as a master 
control volume to normalize project audio levels prior to movie 
export.  

Text 

• In-Place Text Editing 
Add titles, captions, and credits as separate text clips or as overlaid 
text ("floating" over your video). 

• Text Styles 
For titles, captions, and credits, the new Text Styles gallery offers 
hand-picked styles for that professional look. Apply a full range of 
character formatting for custom text styles. 
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• Text Animation 
Bring text to life by choosing In and/or Out animations. Fly, Spin, 
Blinds, Explode, and Type are among an impressive collection of 
preset categories. 

Transitions, CG Clips, and Effects 

• Cool Transitions 
Automatic transitions between two clips make MoviePlus a breeze. 
MoviePlus offers dozens of built-in, customizable transitions allowing 
you to use standard transitions like wipes and cross-fades through to 
stretches, pushes, pixellation, and 3D transitions. 

• Computer Generated (CG) clips for Enhanced Movie Titles 
For movie interludes or backdrops to titles or credits, add coloured 
Backgrounds (solid or gradient fills) or Images and QuickShapes 
such as hearts, chevrons, teardrops, and zigzags (plus many more). 
QuickShapes are also great for masking effects! 

• Stunning Video Effects 
Enhance your movies with a wide range of customizable correction 
filters—pick from brightness, contrast, gamma adjustments, sharpen, 
noise reduction, stabilize, and many more! Special effects include Old 
Film, Motion Blur, Mask, Noise, and Chroma Key. 2D filter effects, as 
well as 3D lighting and surface effects are supported. Apply 
individually or cumulatively. Even perform reverse video playback as a 
special effect. 

• Audio Effects 
Choose from a range of audio special effects—Reverb, Bass, Fill Left, 
Fill Right channel-related effects. Even use third-party VST effect 
plug-ins. 
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Performance 

• Pre-Rendering for Improved Video Playback 
Render transitions, video clips, or a time range in the background for 
improved preview performance; lightning fast previews for complex 
timelines or clips with processor-intensive effects! 

• Background Task Management 
For uninterrupted project development, pre-rendering and proxy file 
generation are initiated as background tasks. Prioritize or delete any 
background tasks in Background Task Manager. For example, 
prioritize a proxy task for a specific HD video clip to complete ahead 
of other tasks. 

• Helper File Manager 
Monitor, manage, and remove helper files used for pre-render 
preview, proxies, indexing, scene detection, waveform generation, and 
motion control. Allocate disk space thresholds for automatic helper 
file deletion—avoid running out of disk space ever again! 

Ease of Use 

• Easy-to-use Panes 
Enjoy intuitive panes which can float and be resized to make your own 
MoviePlus workspace!  

• Full Screen preview 
Test your project in full screen view, with supporting pop-up transport 
controls—even preview on additional monitors. 

• Editing Toolbars for More Efficiency 
Context-sensitive toolbars for storyboard and timeline; toolbars only 
offer the tools you need, when you need them. 

• Switch Editing Modes 
Swap between the simplicity of the storyboard and the editing power 
of the timeline. A single click gives an easy jump between either mode. 
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• Guides for Fine Positioning 
Use for laying out your titles, images, shapes, and transform 
adjustments on your clips. Guides are for display only, helping you 
arrange clips and objects, and can be positioned either by drag-and-
drop or dialog. 

• Customized Keyboard Shortcuts, Menus, and Toolbars 
Take advantage of customizable keyboard shortcuts—assign your own 
keystrokes to toolbar and menu commands! Tailor MoviePlus to your 
needs with menu, toolbar, and icon customization. 

Exporting 

• Easy Exporting 
Export to any media, file or device using either suggested project 
settings, intelligently calculated by MoviePlus, or by creating custom 
project settings, which can be saved. 

• Share Worldwide with YouTube 
Export your movie then automatically upload to your YouTube 
account. 

• Export to all the latest Apple devices 
Share your movie via your Apple iPad, iPad2, iPhone (all models), 
iPod Touch, or iPod. 

• Built-in DVD Authoring! 
Bring your movies to the masses with quick and easy authoring to disc 
(includes auto-erase)! 

• DVD Menu Designer 
For handy chapter navigation, the Menu Designer lets you create your 
very own multi-level disc menus from a diverse range of pre-built 
templates, by changing layout, background images/music, titling, and 
button styles. The designer also offers Disk Preview (with remote 
control simulator), video menu backgrounds, and manual positioning 
of menu buttons. For multi-page menus, each page can adopt its own 
appearance (e.g., layout, background, etc). 
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• Create Blu-ray discs! 
With MoviePlus you can create and share your completed project via 
Blu-ray discs. 

• AVCHD on DVD 
Export your HD project (AVCHD) to DVD, either taking advantage of 
cheaper media costs (compared to Blu-ray discs) or if you've not yet 
purchased a Blu-ray writer! 

New features 
• Easy-to-Create Themed QuickMovies (p. 32) 

Make eye-catching movies based on popular themes, with no prior 
knowledge of video editing! Each theme is made up of preset titles and 
credits, with combinations of movie overlays, effects, and transitions—
you just need to add your video clips or images! Match your disc menu 
designs to your QuickMovie theme for that professional touch. 

• New Colour and Lighting Adjustments (p. 37) 
Correct your video or image clips with two new corrective 
adjustments—Colour adjustment for Temperature (White Balance), 
Tint, Saturation, and Vibrance control; Lighting adjustment for 
Exposure, Brightness/Contrast, Shadows/Highlights, and Clarity 
control. Video clips with wildly varying exposure levels can be 
improved by intelligently correcting exposure over the clip's duration. 

• 3D Transforms for Amazing Clip and Track Motion (p. 105) 
Apply transforms that can move in three dimensions—all from the 
Video Preview pane. Tumbling and spinning effects all become 
surprisingly easy and fun, thanks to a on-screen movable orbit circle. 

• Convert Video Files (p. 195) 
The Startup Wizard's Convert Video Files... option lets you select one 
or more files of any video format and convert them quickly and easily 
to a video file format of your choice—all without entering your 
MoviePlus workspace! Great for batch processing your movies in 
readiness for upload to the web! 
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Ease of Use 

• Centralized Editing of Properties 
The improved Properties pane lets you apply and manage adjustments, 
effects, and transitions, as well as clip, track, and group properties—all 
from one location! Time consuming jumps between pane and 
storyboard/timeline are no longer needed, freeing up precious movie 
editing time. For keyframe control and changing properties over time, 
the pane's Show Keyframes option lets you display, add and edit 
keyframes only when you need to. 

• Inserting Text Made Easier (p. 147) 
Add titles and captions more easily via Insert Text on either the 
Storyboard or Timeline toolbar. The Video Preview pane's Text 
button lets you add captions (and then more text objects) to any type 
of clip directly under the Time indicator. 

Exporting 

• Share via Facebook! (p. 192) 
Upload your completed movie to the social networking website, 
www.facebook.com. 

• Export Settings for the Latest Portable Devices (p. 173) 
Try out improved export settings for all the popular Apple devices 
(including iPad2 and iPhone4S) and PSP; settings for YouTube and 
Vimeo upload have also been optimized. Independent MP4 upload to 
Android phones and Facebook keeps MoviePlus X6 ahead of the 
competition. 

• Title and Label Text Styles for Menu Designer (p. 178) 
Ready-to-go text styles now allow the titles and labels in your disc 
menus to complement your movie's text clips. 

• Automatic Export Letterboxing (p. 173) 
If the aspect ratio in your project settings does not match your export 
settings, MoviePlus now exports with black “letterbox” borders rather 
than transform your project. 

http://www.facebook.com/
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• AVCHD Progressive Support for HD TV Display (p. 187) 
For AVCHD Progressive camcorder owners, share your HD movie on 
Full HD TVs! Simply export as a file (M2TS) using the new AVCHD 
Progressive export option and make it available to your TV. 

Licensed feature unlocking 
As part of the MoviePlus import or export process, a new feature may have to be 
unlocked—this is purely for Serif licensing reasons and does not incur any 
charge. If a feature needs to be unlocked, MoviePlus will connect to the internet 
to automatically unlock it. If the automatic feature unlock fails (i.e., if there is no 
Internet connection) you will be prompted to that effect, then you can manually 
unlock the feature (see MoviePlus Help for details). 

Once unlocked, the MoviePlus feature will be freely available and will not need 
unlocking again on your computer. 

 In unlocking, Serif does not gather personal information from your 
computer, or any other information that may impinge 
confidentiality. 
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Installation 

System requirements 

• Windows-based PC with DVD drive and mouse 

• Microsoft Windows® XP (32 bit), Windows® Vista, or Windows® 7 
operating system 

• 1GB RAM 

• 999MB free hard drive space (minimum)* 

• 1024 x 768 monitor resolution (1280x1024) 

• An Internet account and connection (for Auto Update and export to 
YouTube and Facebook) 

* Additional disk resources are required when exporting projects 

For use with non-HD video and HD video (proxy support): 

• Intel® Pentium® 4 Hyper-Threaded processor or AMD Athlon™ XP 
processor 

For use with HD video (optional proxy support): 

• Intel® Pentium® 4 Hyper-Threaded processor or Dual-core processor 

• Fast hard disk (≥7200rpm drive) 

For use with Full HD video (native AVCHD 1080): 

• Quad-core processor 

• 2GB RAM 
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Input device support 

• FireWire® (IEEE1394) support for connecting tape-based camcorders 

• USB support for file-based camcorders 

• Video capture card for digitizing and editing analogue video clips 

Output device support (for disc creation) 

• CD-R Writer (for VCD) 

• DVD±R (for DVD and AVCHD) 

• Blu-Ray™ Disc Writer 

Optional 

• Windows XP Service Pack 2 (for HDV video capture) 

First-time install 

To install Serif MoviePlus X6, simply insert the disk into your computer's drive. 
The AutoRun feature automatically starts the Setup process. Just answer the on-
screen questions to install the program. 

Re-install 

To re-install the software or to change the installation at a later date, select 
Settings/Control Panel from the Windows Start menu and then click on the 
Add/Remove Programs icon. Make sure the MoviePlus X6 disc is inserted into 
your drive, click the Install… button and then simply follow the on-screen 
instructions. 
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Startup Wizard 
Once MoviePlus has been installed, you're ready to start. Setup adds a Serif 
MoviePlus X6 item to the All Programs submenu of the Windows Start menu. 

• Use the Windows Start button to start MoviePlus (or if MoviePlus is 
already running, choose New>New from Startup Wizard... from the 
File menu) to display the Startup Wizard. 

 

The Startup Wizard offers different routes into the program for you to explore: 

• Start New Project, to create a new project without adding media files. 

• Create a QuickMovie, to create a movie based on a pre-supplied 
theme (e.g., holiday). Use for making movies quickly without having 
video editing experience. 

• Import from Disk, to add media files from your computer drive to a 
new project. 

• Copy from Device, to copy and add media files from your file-based 
camcorder (or removable device) to a new project. 
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• Capture from Device,  to capture video footage from your tape-based 
camcorder or analog device. (See MoviePlus Help for more details.) 

• Convert Files, to convert video files (of differing formats) to a 
common video format (e.g., *.mp4). 

• Open, to quickly access previous MoviePlus projects. 

• Learn, to access online tutorials and more resources. 

The Startup Wizard is displayed by default when you launch MoviePlus. You 
can switch it off via the Don't show this wizard again check box on the Startup 
Wizard screen, or on again via Startup Wizard in Tools>Options... (use the 
General menu option). 

Click the  Cancel button or press Escape on your keyboard to bypass the 
Startup Wizard and launch MoviePlus with an empty project. The type of 
project will match the last project you selected. 

 You can also access the Startup Wizard at any time from New>New 
from Startup Wizard... on the File menu. 

Starting a new project 
By default, MoviePlus will be launched in Timeline mode (see p. 57), a time-
based multi-track workspace traditionally used by video editors. 

Creating MoviePlus projects 

MoviePlus bases its movie compositions around "projects". A MoviePlus project 
file is a collection of project settings (the video size and shape, audio properties, 
aspect ratio, etc.) plus information about how all your clips are arranged and 
presented. 
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The Startup Wizard lets you create projects in three separate ways: 

 Start New 
Project 

Creates a blank project without adding media files. 

 Create a 
QuickMovie 

Creates a ready-to-go themed QuickMovie (p. 32), based on 
a one of many selectable themed presets (e.g., Balloons, 
Bedtime, Carousel, etc.) 

 Import 
from Disk 

 Copy 
from Device 

Creates a project based on: 

• imported media already on your computer 
drive(s). 
OR 

• copied media that will be immediately 
transferred from your camcorder (or other 
removable device) to your computer drive, and 
then imported into MoviePlus. 

Start New Project 

To start a new blank project (via Startup Wizard): 

1. Open MoviePlus to display the initial Startup Wizard (if switched on). 

2. Select Start New Project. On first use, your project is based on PAL 
DVD project settings. For subsequent sessions, MoviePlus will 
remember and use the project settings used in the previous session. 

To start a new project: 

• Click  New on the Standard toolbar (only if Startup Wizard is 
turned off). 

With either method, the newly created blank project is now ready to have media 
files added to it (see p. 22). 
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 You can quickly check your project settings from the Status Bar, or, 
in more detail, via File>Project Settings....  

Import/Copy from Device 

If you want to add media files immediately, you can base your project on your 
media file's source format. For example, as you add HD media files, your project 
will intelligently use HD project settings matching those specific media files. 
Your project is then set up with media files already present. 

To create a new project that matches your media files: 

1. From the Startup Wizard, choose: 

• Import from Disk. Locate and select your media files already on 
your computer drive, then click Open. 
OR 

• Copy from Device. Using a wizard, choose your target device 
(e.g., file-based camcorder or DVD), select files, then click Finish. 

2. From the dialog, click Yes to change project settings to match the 
media file's source format. Click No to retain the project settings used 
in the previous session (ignoring the media file's format). Check Don't 
ask me again if you don't want to be prompted in future. 

See Adding media files to your project (p. 22) for more information. 

 In timeline mode, you can base your project on a clip's source 
format at any time by right-clicking a video or audio clip and 
choosing Set Project Settings From Clip. 

 As your project settings will be matched to your imported/copied 
media file, your export settings will also be matched to those 
modified project settings. As a result, choosing complicated project 
settings when starting your project and exporting is not required. 
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Creating custom project settings 

You can customize your current project settings at any time by modifying its 
template.  

To customize project settings: 

1. Select Project Settings... from the File menu. 

2. From the Project Settings dialog, pick a template in the Templates list 
on which to base your new project settings (or select a Multimedia 
preset for general use). 

3. Click the Modify button to make a copy of the project, now named 
(Untitled). 

4. Change various settings including the dimensions of your project 
(Width/Height), the Pixel aspect ratio (many types of output use 
stretched pixels), the video Frame rate (number of frames per second), 
Interlacing, and Audio sampling rate. 

5. When you are happy with your settings you can save your project 
template for reuse—simply click the Save button, type a new preset 
name and click OK. 

Opening an existing project 
You can open an existing MoviePlus project from the Startup Wizard, Standard 
toolbar or the File menu. 

To open a recently opened or saved project: 

1. From the Startup Wizard (at startup time or 
via File>New...), select your project from the 
Open section. The most recently opened or 
saved project will be shown at the top of the 
list. 

2. Click the project name to open it. 

 Recently viewed projects also appear at the bottom of the File 
menu. Simply select the file name to open it. 
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To open any project: 

1.  From the Startup Wizard (at startup time or via File>New...), 
click Browse.... 
OR 
 

Click  Open on the Standard toolbar. 

2. In the Open dialog, navigate to, then select the project name and click 
the Open button. 

 You can also open projects by file drag-and-drop from Windows 
Explorer onto the MoviePlus workspace. 

Adding media files to your project 
The media files you use for your project could reside on your camcorder, mobile 
phone, digital camera, or computer drive (local, network, or removable disc). 

You can add media files from these locations as you start a new project (p. 18) or 
at any time by copying, importing, capturing, or "ripping" media files into 
MoviePlus's Media pane. 

 

 If you've not already imported media files directly from the Startup 
Wizard, you can use the Import Media button on the Tasks toolbar or Media 
pane. The drop-down list lets you: 
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Import The Add media dialog lets you navigate to, then select one or 
more media files from your local disk or network drive for 
import directly into your Media pane. Use Shift-click or Ctrl-
click for adjacent or non-adjacent multiple selection before 
import. 

Copy 
from 
Device 

Copy media from your file-based camcorder (or DVD or Flash 
equivalents), USB Hard drive, USB memory stick, memory card 
reader, or CD/DVD. 

• From the Copy from Device option, select the 
connected Device as a remote drive in the dialog, then 
click Next>.  

• In the next screen, the device's media files can be 
selected and copied to your computer's Destination 
folder by clicking Finish. 

Selected files show in the Media pane automatically. 

Capture With your tape-based camcorder connected via USB/FireWire 
you can capture your movie's video footage and/or audio to a file, 
with optional scene detection. 

Rip CD Rip audio tracks from your favourite audio CDs straight into the 
Media pane. Not available from Startup Wizard. 

The Media pane 
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The main purpose of the Media pane is to manage your media files before 
committing media to your storyboard or timeline, i.e. 

• You can reorder files by clicking and dragging thumbnails into the 
position you wish them to appear on the storyboard (or timeline). 
 

 

•   You can fix incorrectly oriented images or movies obtained 
from your digital camera by using the Rotate Left and Rotate Right 
buttons. 

• Trimming (p. 24) can be carried out by using  Trim. 

Until now, we've just been describing the Project tab. Two other tabs, Library 
and Explorer, are also available in the Media pane. The former stores media files 
for future use while the latter provides a "window" to your computer's folders 
and files—you can use media files directly from here but you won't be able to 
manage your files as you can from the Project tab.  

Trimming 
With audio or video clips, both duration and playback speed come into play. 
Most often, you'll want to shorten a clip without altering its playback speed—this 
is called trimming. For example, media files seldom begin or end exactly where 
you'd like; there may be extra frames at the beginning or end, or you may want 
to use a short section from the middle of the file. The solution is to trim the 
media file—adjusting its start and end point, called "in" and "out" points, to 
include just the section of video you want. 

For any clip you can split your clip up into separate scenes, with each scene 
capable of being edited as for any other clip. 
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Clips can be trimmed or split in either your Media pane, or via the Storyboard or 
Timeline, by using the Trim dialog. Direct timeline trimming is also possible 
(see MoviePlus Help). 

 

(A) Frame Preview, (B) Clip timeline, (C) Discarded end frames, (D) Out point, (E) 
Set In/Out Point, (F) Split, (G) Trim mode, (H) Playback controls, (I) Display 

controls: Show/Hide Video, Show/Hide Audio, Undo/Redo, Delete Scene, Zoom 
Out/In, (J) In point, (K) Discarded start frames. 

To trim a single clip: 

1. In the Media pane, select a clip and click  Trim. 
OR 

Select a video clip on the storyboard (or timeline) and click  Trim 
on the context toolbar. 

2. From the Trim dialog, to trim to a specific time/frame (using the 
Frame Preview): 
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1. Hover your mouse cursor over the "In point" or "Out 
point" trimming handle on the left (or right) edge of the 
clip's timeline so that it changes to the Trim cursor. 

2. Drag each handle to the frame where you wish to trim 
before (or after). Use the dialog's time/frame readout 
for accurate frame-by-frame navigation. 

  
 
OR 

1. Drag your time indicator into position on the Timeline 
ruler (or use your arrow keys). 

2. Click the  Set In Point or  Set Out Point 
button (or use the keyboard shortcuts I or O, 
respectively). The unwanted portion of the clip will 
appear in grey shading; the portion to be kept is 
highlighted in orange. 

3. Click the OK button. 

 You can move the  Slip handle to shift the in/out points of a 
trimmed clip at the same time. This "sliding window" lets you 
change the content of the trimmed clip without changing its 
duration. 

Multi-trimming and splitting 

MoviePlus lets you create multiple trimmed clips, called scenes, from a single 
video clip. You may want to do this to remove unwanted footage within your 
clip, e.g. removal of poorly recorded frames, or simply just to create more 
manageable scenes for flexible video editing. 
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Multi-trimming simply involves either the creation of multiple in/out points or 
splitting your clip; both methods let you define a new scene equally. Splitting on 
its own does not remove content (like trimming) but instead just chops the clip up. 

To apply multi-trimming: 

1. From the Trim dialog, click Multi-trim. 

2.   Set the time indicator position successively for every in and 
out point, by clicking Set In Point then Set Out Point (or use the 
keyboard shortcuts I or O, respectively) in turn as you move along the 
timeline. Unwanted portions of your clip will appear in grey shading; 
the portions to be kept appear as scenes in the dialog's right-hand 
pane. The orange portion indicates current selection. 
 

 

Newly created scenes are added to your Media pane's Project tab (under a Scenes 
folder). They can then be added to your Storyboard or Timeline. 

To split your clip: 

1. Display the Trim dialog as described previously, then click the Multi-
trim button. 

2. At the time indicator's position, click the  Split button (or use the 
keyboard shortcuts S). You'll see a new scene being created in the 
dialog's right-hand pane. 

3. Repeat for creating multiple split clips. 
 



28  Getting Started 

 

 
 
The thin black vertical lines indicate the split positions (there are three 
splits in the above example, creating four separate scenes). 

Previewing your project 
The Video Preview pane will help you check that your movie editing is going 
according to plan. You can preview your project at any time; MoviePlus will 
begin playing your video, will compose a realistic end result from the contents of 
your all video tracks, and will incorporate all transitions, effects, and 
adjustments on the fly. Audio levels can be checked at the same time. 

You can even continue editing your project while the preview is playing as your 
edits will be incorporated into the preview in real-time. 
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The lower playback controls operate much like your DVD player controls and 
allow you to navigate around your project during preview. 

 

Go to Start 
Jumps to the start of your project. 

 

Previous Frame 
Jumps to the previous frame in your project. 

 
 

 

Click the Play or Pause button to start and pause 
the video preview, respectively. On play, the 
preview will begin from the current preview 
marker's position. 

 Press the Space bar to play and 
pause. 

 

Click the Stop button (or ESC key) to stop your 
video preview and reset the preview back to 
where it originally started. 

 

Next Frame 
Jumps to the next frame in your project. 

 

Go to End 
Jumps to the end of your project. 

 Shuttle 
Allows you to vary the preview playback speed 
and direction by dragging from the centre point 
to the left (to reverse) or to the right (to fast 
forward); release the mouse to snap back to 
normal play speed. This is known as "trick play". 
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Additional buttons at the bottom of the pane offer previewing and editing 
options. 

 

Select Tool 
Lets you select objects (text, images, and shapes) in the pane for 
editing. 

 

Pan Tool 
Lets you drag an area of your video around the pane. When used with 
the right-click Zoom in option, this allows for more detailed analysis 
of your project. 

 

Transform Tool 
(Only shown when a transform adjustment is applied) The 
Transform button switches on the transform region to let you adjust 
your transform positioning in two dimensions. 

 

3D Transform Tool 
(Only shown when a transform adjustment is applied) The 
Transform button switches on the transform region to let you adjust 
your transform positioning in three dimensions. 

 
  

Add Caption/Add Text Object 
Can be used to add either a caption onto the currently displayed clip 
or a new text clip if no video clip/image is currently being previewed. 
(See Adding text on p. 147). 

 

Add Image 
The button is used to add an image object to your text clip. This 
could be a saved frame (see below). 

 

Add QuickShape 
A QuickShape object can be created on your text clip within this 
pane. 

 

Guides and Borders 
From the flyout, switch on/off layout guide lines and a TV-safe 
border. 
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Save/Copy Frame 
The flyout allows the currently displayed frame to either be saved to 
an image file (use Save Frame...) or copied to the Clipboard (Copy 
Frame); the image can then be pasted as a graphic into a photo 
editing program, e.g. Serif PhotoPlus. Saving a frame adds the created 
image to your Media pane (Project tab). 

Previewing in full screen 

At some stage you may want to view your project in full screen view. As well as 
being able to see how your movie looks on a larger scale you'll be able view your 
project without guides and make use of dual monitors (one set at default size 
and one set as full screen). 

To view in full screen: 

• Click  Full Screen on the Tasks toolbar. 

 Playback controls disappear during preview but reappear with a 
mouse movement. 

To close full screen view: 

• Click  Close to exit from full screen view. 

Dual-monitor use 

With dual monitors you can instantly preview your changes as you perform 
video editing. If you're a dual-monitor MoviePlus user, you can display your full 
screen view on your secondary monitor easily. 

To operate dual monitors: 

1. In full screen preview, click the  button. 

2. From the drop-down list, enable the "Monitor x" option from the 
drop-down list (where x is the secondary monitor number). 

After closing full screen preview, the setting is remembered. The secondary 
monitor will automatically be used again for full screen preview. 
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Improving playback performance 

If you're experiencing poor playback performance (e.g., stuttering) you can: 

• Reduce the Render Quality (Preview menu). 

• Use pre-rendering. Select Pre-render All (Preview menu). 

• (For HD video), use proxy files in conjunction with pre-rendering 
when using computers that do not possess a quad-core processor. 

Consult the Performance notes (p. 197) for more information. 

Creating a themed QuickMovie 
If you're looking for a professionally designed themed movie, look no further 
than QuickMovie Studio. The studio offers quick and easy movie creation using 
a step-by-step approach, all without the need for advanced video editing skills.  

 

QuickMovie Studio 

The key screen-by-screen steps when using QuickMovie Studio are: 

• Choosing a theme (below) 

• Importing your media 

• Personalizing your movie 

You'll also be able to customize a theme, which can optionally be saved for 
future use. 
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To start QuickMovie Studio: 

• From the Startup Wizard, select Create a QuickMovie. 

 
 
When you've created a QuickMovie, you can edit it at a later date, perhaps 
swapping your theme for another or adding further videos or images. 

To edit an existing QuickMovie: 

• From the File menu, click Edit QuickMovie. 

If you already have a simple MoviePlus project created using the Storyboard or 
Timeline mode, you can also convert it to a QuickMovie, making use of the 
simpler QuickMovie Studio environment. 

To convert a project to a QuickMovie: 

• From the File menu, click Convert Project to QuickMovie. 

 If you convert a project created using a multi-track timeline, only the 
lowest video track will be retained on conversion. 
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 The Edit QuickMovie option only displays if you've already created a 
QuickMovie. Otherwise, Convert Project to QuickMovie will be 
displayed by default.  

Choosing a theme 

QuickMovie Studio allows you to base your movie on a specific theme (e.g., 
Balloons, Bauble, Bedtime, etc). Each theme includes a preset opening animation 
and background, as well as professionally designed overlays, effects, and 
transitions that can be applied to your imported clips. 

All the available themes are displayed as selectable thumbnails when you initially 
launch QuickMovie Studio. 

Importing your media 

The Import Media dialog offers Import, Copy from Device, and Capture 
options identical in function to those available on the Startup Wizard (p. 15) or 
Media pane (p. 23). 

Personalizing your movie 

Your movie is put together using your chosen professionally designed theme and 
your videos and photos. In the Edit Details screen, the preset theme contains 
text placeholders for the movie titles and credits. You are likely to edit the 
default text to better describe your movie and personalize your titles and credits 
using text formatting options or a preset text style from the gallery. 

To edit and format titles and credits: 

1. Click in the box and type your title or credit text. 

2. Select a font, font size, character formatting, alignment, fill and line colour, 
transparency, and effects from the appropriate text formatting options. 
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OR 
 

Click  Style and select a thumbnail preset to set the style of your 
text. 
 

 

Your movie will have an overall Duration, determined by three aspects: 

• the duration of each imported video file (or image file). 

• the duration of titles and credits. 

• the Clip Overlap setting within your movie. 

The overall duration of your movie can also be modified by setting a Duration 
for all images in your movie. 

Background music may be added to your movie to accompany your footage. 
Preset clips or your own music clip can be chosen.  

You may also wish to add visual interest to images in your movies by using a pan 
and zoom effect. 

Customizing your theme 

By default, your theme possesses Title and Credits settings including Start/End 
animation, thumbnail animation, background, music, and fading controls. In the 
Edit Details screen, if you click >> More, these advanced settings can be 
displayed and customized to suit your movie. Your movie's "body" content can 
also be customized to introduce different overlays, effects, and transitions to 
clips.  

Any custom theme can be stored by clicking Save Theme.... In the future, the 
theme will be available to you from QuickMovie Studio’s Choose a Theme 
dialog. 
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Exiting QuickMovie Studio 

With your themed movie now complete, your movie will be added to the 
Timeline (p. 57) for further video editing if needed. You'll be able to save your 
movie as for any other MoviePlus project and optionally edit it later, again in 
QuickMovie Studio, from the File menu (Edit QuickMovie...). 



 

 

Making Adjustments 3 



 38 Making Adjustments 

 

 



Making Adjustments 39

 

Applying adjustments 
There are different types of adjustments available within MoviePlus for both 
video and audio clips.  

• For video clips: Opacity, Crop, Transform, Colour, Lighting,  
Noise Reduction, Stabilize. 

• For audio clips: Volume and stereo Pan. 

Adjustments can be edited, copied, pasted and muted. 

Once you learn how to display and modify one type of adjustment, you can 
apply the same principle to all other adjustment types. 

In Timeline mode, some adjustments (e.g., Opacity and Transform), can also be 
applied to tracks or groups which will affect all clips on the track, or all tracks in 
the group. For example, adjustments to a video group's opacity will result in 
opacity changes to the composite result of the group's contents. If a video group 
contains four tracks each with a transform adjustment that makes each track fill 
just one quarter of the visible area, all four videos would simultaneously have 
their opacity adjusted when you modify their group's opacity. Groups are also 
used when cropping or masking video, so you may want to adjust the group's 
opacity—rather than individual tracks or clips. 

Applying adjustments 

To apply an adjustment: 

1. Select the clip (clip, track or group in Timeline mode). 

2. From the Properties pane, select an adjustment.  
 

 

3. Edit the adjustment's parameters in the displayed pane. 
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The adjustment will then show an  Applied Property indicator next to its 
name to indicate that it has been applied (and modified). 

  If you've made your adjustments change over time (p. 86), the 
above indicator will possess a red centre to indicate that keyframes 
are being used. 

MoviePlus also provides a great selection of preset adjustments to apply to your 
clips, tracks or groups. Use the presets to get you started or to simply save you 
time. 

To apply an adjustment preset: 

1. From the Galleries pane (Adjustments gallery), select your adjustment 
type (e.g., Crop). You may need to click  to reveal adjustment 
categories. If so, select the adjustment type (e.g., Zoom) once you've 
expanded the category. 

2. Drag and drop your chosen adjustment onto the clip (clip, track or 
group in Timeline mode). Your adjustment shows automatically under 
the object. 

To save an adjustment: 

• Click  Add to Gallery in the adjustment's Properties pane. After 
providing a name, your new adjustment is saved in the Galleries pane 
(Adjustments gallery), under the appropriate tab. 

To display an applied adjustment: 

• Select the clip, track, or group. 

• From the displayed Properties pane, select the appropriate 
adjustment's tab.  

 If an adjustment has been applied, the adjustment tab shows a 
check mark after its name.  
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Managing adjustments 

To reset an adjustment: 

• Click  Reset in the adjustment's Properties pane. 

To mute an adjustment: 

• Click Mute in the adjustment's Properties pane. (  Video; 
 Audio) 

The  Applied Property indicator displays in a paler colour if the adjustment 
has been temporarily muted. 

To copy an adjustment: 

• Drag and drop the adjustment's name from the Properties pane onto a 
"target" clip, track, or group. 
 
OR 

• Click  Copy in the adjustment's Properties pane. To apply, right-
click a "target" clip, track, or group and select Paste. 

A powerful feature of MoviePlus's Timeline mode is the ability to change 
properties (of adjustments, effects, or transitions) over the clip's playback 
duration. This is done by using keyframes, placed under the clip on the timeline. 
Each keyframe possesses its own properties, which affect the clip from that 
keyframe position onwards. Tracks and groups can be affected similarly. For 
more details, see Changing properties over time (p. 86). 

Cropping 

You can perform simple crops on any clip by using the  Fit button in either 
Storyboard or Timeline mode (See Resizing clips on p. 45). This affects the clip 
for its entire duration. 
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Cropping can also be applied from the Properties pane by resizing the clip's crop 
region.  

To apply a crop adjustment: 

1. Select a clip. 

2. Select the Crop adjustment from the clip's Properties pane. 

3. From the Parameters section, resize the crop region by dragging its 
corner or edge handles. 

 

 

 

You can also use Alt-drag to crop to the clip's centre. 

Alternatively, you can set the crop area manually by entering Top, Bottom, Left 
or Right percentage values (click the Manual drop-down option). 

To save your modified adjustment: 

• Click  Add to Gallery in the adjustment's Properties pane. You'll 
be asked to enter an adjustment name. The adjustment is saved to the 
root Crop folder of the Adjustments dialog and the Galleries pane 
(Adjustments gallery). 

Crop presets which change the cropping over time are available from the 
Galleries pane. 

To apply a crop preset: 

1. From the Galleries pane (Adjustments gallery), select your adjustment 
(e.g., Crop) and an adjustment type (e.g., Zoom).  

2. Drag and drop your chosen crop adjustment onto the clip, track or 
group. 
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3. From the dialog, navigate the tree menu structure and choose a preset 
crop adjustment. Your adjustment shows automatically under the 
object. 

Cropping with masks (Timeline only) 

As a very powerful way of cropping irregular shaped objects (as opposed to 
cropping to square or rectangle areas), cropping video with masks involves using 
a simple image overlay to describe which areas of your video should remain 
visible and which areas should become transparent. 

Masks are usually simple images made with a transparent region and a white 
region; when applied correctly in the MoviePlus timeline, these images affect 
underlying video, with white in the mask translating to visible regions of your 
video and transparency in your mask translating to transparent (cut/cropped) 
regions of the video. You can use this functionality to hide (or crop away) 
portions of your video that you do not want included. Masks allow for irregular 
cropping, cropping with soft edges, animated cropping; the possibilities are 
infinite, as are the number of mask images or videos you can create. 

For more information see Masks on p. 99. 

Using pan and zoom 
Pan and zoom "Ken Burns" effects can be used on any clip, but the effect really 
comes into its own when used on image clips. Rather than displaying clips that 
always display at the same size, you can easily apply panning and zooming 
effects that create variety and interest in your project. 
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The effect is applied by using a dual-pane dialog, the left-hand "start" pane 
representing the start of the clip and the right-hand "end" pane, the end of the 
clip. Simply adjusting the resizable selection area in each pane sets the zoom 
level or pan position. 

 

To pan and zoom your clip: 

1. Click the clip on the storyboard (or timeline). 

2. Select  Pan & Zoom on the context toolbar. 

3. From the dialog's "start" pane, drag a corner or edge control handle 
(for maintaining aspect ratio or unconstrained sizing) on the selection 
area. Use the Alt key to resize the area in relation to the centre of the 
area (rather than the opposite corner or edge). Once sized, reposition 
the area with the hand cursor. If needed, click the Reset button to reset 
each selection area back to the default size. 

4. Adjust the area on the "end" pane in a similar way. 

5. (Optional) Click Match project aspect on either pane to make the 
aspect ratio of that pane's selection area match that of your project. 
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6. (Optional) Check Ease In or Ease Out on respective panes to apply a 
non-linear rate of change to your pan and zoom (Quadratic slow 
interpolation). 

7. (Optional) Check Exclude Transitions to restrict Pan & Zoom to clip 
regions without the transition applied. When unchecked, Pan & Zoom 
will be applied across the whole clip.  

8. Click Close to save your resized or repositioned areas. 

The result is two sized areas which, on playback, MoviePlus will pan and zoom 
between according to the position and size of each area, respectively. 

Resizing clips 
The shape of your video (or image) clip in the Video Preview pane is determined 
by your project settings. If you add a clip whose dimensions don't match the 
current project settings, MoviePlus will automatically letterbox your added 
clip. From this point, you can choose to: 

• Manually crop the clip to remove the letterboxing. 
OR 

• Change the project to match the newly added clip's dimensions.  

Manual cropping removes unwanted borders by either fitting the clip to the 
Video Preview pane or by defining a crop area you draw yourself (anything 
outside the area is discarded); the clip is resized to fit the project. Cropping is 
normally applied to image clips added to a project (if of unusual dimensions or if 
in Portrait orientation). 

To control resizing,  Fit on the Storyboard or Timeline toolbar displays 
both automatic and manual settings. The automatic settings Auto (Crop) or 
Auto (Letterbox) indicate the default fit mode for the selected clip; the 
remaining settings are for manual resizing. 

 

 



 46 Making Adjustments 

 

To manually resize a clip: 

1. Select the clip. 

2. Click  Fit from the Storyboard or Timeline toolbar and pick a 
resizing option from the drop-down list. 

 

Crop - Select to manually crop the clip to make it 
fit with the project size thus removing any 
letterboxing. The clip's aspect ratio is maintained 
so that the taller (or wider) areas are left outside 
the visible part of the project. See Cropping on 
p. 41 for more information. 

 

Letterbox - This displays the entire clip and 
maintains its original aspect ratio. The project's 
background (usually black) may show on the 
horizontal or vertical edges. 

 
  

Stretch - Stretches your clip horizontally or 
vertically to match the project video size—
removing the letterboxing effect, but changing 
the clip's aspect ratio. 

 

Custom - Launches the Crop dialog that lets you 
remove everything outside a defined crop area. 
Size the crop area by moving corner handles 
(maintaining aspect ratio) or side handles (alters 
aspect ratio) then position the crop area again by 
dragging; the clip will resize to fit the crop area. 
Click Match project aspect to set the crop area to 
the project aspect ratio. 

 You can double-click on the crop area to reset its size back to the 
project’s dimensions. 
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Storyboard basics 

 If you're in Timeline mode, click Storyboard to switch to Storyboard 
mode. 

Storyboard mode provides the user with a simplified approach to movie 
making. If you're a beginner to video editing or you've no requirement for more 
complex multi-track editing techniques, the storyboard offers an easy-to-use 
workspace to build up your project and visualize different scenes in your movie. 
The easy-to-use storyboard is particularly suited to creating simple photo 
slideshows or movies containing a mixture of image and video clips. 

A major strength of the Storyboard mode is its simplicity. You'll only see 
options, buttons, and dialogs that are needed for simple projects with the more 
advanced multi-video-track editing controls being hidden in another mode, 
called the Timeline mode (see p. 57). Think of the Storyboard and Timeline 
modes as being like two sides of a coin—you can flip between modes to jump 
between basic and advanced use any time you like. 

 

(A) Text clip, (B) Video clip, (C) Time indicator, (D) Image clip, (E) Clip name, 
(F) Pan & Zoom, (G) Applied Property indicator, (H) Transition, (I) Chapter point, 

(J) Caption, (K) Duration, (L) Audio clip, (M) Audio clip (Narration).  
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Text clip 
A text clip can be added for use as a static or rolling title or as credits. The clip 
has its own duration, and can be treated in a similar way to video/image clips. 
Additional text, as separate text objects, can be added onto the clip as captions. 
See Adding text on p. 147 for more information. 

Video and image clips 
Video and image clip thumbnails, representing your media elements, appear on 
the storyboard when added by drag-and-drop from the Media pane. 

Time indicator 
In storyboard mode, the time indicator is used to carry out a preview playback of 
your project from that point. The time indicator is also shown in the Video 
Preview pane for the same purpose. 

Clip name 
The clip name is the name of your media file by default. If required, you can edit 
the name in the Properties pane (General tab) while the clip is selected. 

 Pan & Zoom 
The Pan & Zoom icon indicates that a Pan & Zoom effect has been applied to 
the clip. Click the icon to view the current effect in the Pan and Zoom dialog. 
See Using Pan and Zoom on p. 43 for more information. 

 Applied Property Indicator 
If an effect or adjustment has been applied to the clip, or a clip property has 
changed (e.g., opacity), the Applied Property Indicator is displayed. 

Transition 
A cross-fade transition with a set duration is added between video clips by 
default; audio clips get a Fade transition. The default transition can be swapped 
for another and have its duration altered. See Applying transitions on p. 81 for 
more information. 

 Chapter point 
The icon indicates that a marker, used exclusively when creating menus for your 
disc (DVD or Blu-Ray Disc), is associated with the clip. The chosen clip will be 
included as a chapter start point in your disc menu. When the chapter is selected 
in the disc menu, your movie will play from the beginning of the chosen clip. See 
Editing chapter properties on p. 182 for more information. 
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 Caption 
The icon indicates that a static or animated caption is added to a clip. They are 
superimposed onto the clip and, like text clips, can adopt a preset text style or be 
customized. Caption text can appear for the clip's duration or for a shorter time. 

Duration 
The duration is the time the clip or transition will be displayed on screen. To 
edit the duration of text clips, image clips and transitions, click under their 
thumbnails to edit their values. A video clip duration will update if the clip's Play 
Speed is adjusted in the Properties pane (General tab). 

Audio clips and Narration clips 
A narration clip is added to a narration strip under your video or image clips 
after recording from a microphone. Likewise, audio clips show on their own 
Music strip that lies below the narration strip. Use both in combination for 
commentary over background music (e.g., soundtracks). 

Adding media files 
Media files show in the Media pane after capture, copy or import (see Adding 
media files to your project on p. 22). Once present, it's a great idea to arrange the 
order of the files prior to adding them to the storyboard. This avoids having to 
rearrange clips in bulk on your storyboard itself. Once you're happy with the 
order you can add the media to the storyboard. 
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To add media to the storyboard: 

1. From the Media pane, either: 

• Click to select a single media file. 
OR 

• For multiple media files: 
 
Use click-and-drag to marquee select (to lasso files under a 
selection region). 
OR 
Use Shift key and click (to select a range of adjacent files). 
OR 
Use Ctrl key and click (to select a range of non-adjacent files). 
OR 
press Ctrl+A (to select all files). 

2. Drag selected media onto your storyboard. 
 
If the storyboard is empty, drag your clips directly into the empty 
workspace. Video or image clips go to the "Drop clips here" target 
areas, while audio clips snap onto horizontal narration or audio strips 
below the thumbnails. 
 

 
 
If video clips are already present, insert your clip between existing 
clips. An insertion point indicates where your clip is to be placed. 

Multiple clips will be added one by one along your storyboard.  
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Selecting clips 
When you are editing your movie and have already added a range of media clips 
to your storyboard, all your editing operations (including moves, trims, 
properties changes and other adjustments) are carried out on the selected clip. 

To select a single clip: 

• Click on the clip. The clip's lower title bar turns orange. 

To select multiple clips: 

• Use Shift key and click (to select a range of adjacent clips). 
OR 

• Use Ctrl key and click (to select a range of non-adjacent clips). 
OR 

• Click Select all clips from the Edit menu (or press Ctrl+A). 

Arranging clips 
The storyboard is a workspace that arranges clips automatically as they are 
dragged to the storyboard. When you first add clips to the Storyboard from the 
Media pane, the storyboard clip order is the same as the clip order in the pane. It 
therefore makes sense to arrange your clips in the Media pane first. As such 
there may not be a necessity to rearrange clips if the clip order is as intended. 
Realistically, it's often the case that you may want to further modify the clip 
order. 

Once on the storyboard, an individual clip can be moved by drag and drop. The 
vertical marker indicates the target location for the moved clip. 
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You can also copy and paste a clip by using options from the Edit menu. Both 
methods can also be carried out on multiple clips simultaneously. 

Deleting clips 

• To remove a clip, select it and press the Delete key. By multiple 
selection, you can remove more than one clip at the same time. See 
Selecting clips on p. 53 for more information. 

Applying transitions 
MoviePlus supports many different transition types. For example, you can 
dissolve (Cross-Fade) between one clip and the next, or apply a variety of 
patterned or 3D wipes. 

Transitions are displayed as inter-clip thumbnails in Storyboard mode, which 
change according to transition applied (the thumbnail represents the transition's 
function). The transition's duration is shown under its thumbnail. Some 
examples include: 

   

Cross-fade (default) 3D Page Roll Blinds feathered 

 Each transition is applied to the start of a clip—this is called an In 
transition. 

 

You may notice a zero-length "transition" at the start and end of 
your storyboard. 
This is a straight cut, but you can create fade ins or fade outs 
from/to black by changing the transition duration from 0.0s. 

To change a transition's duration: 

• Click the duration time under the transition thumbnail, enter a new 
value, then press the Enter key. 
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Changing this value will automatically "ripple" all other subsequent clips along 
the storyboard with respect to time. 

To replace a transition: 

1. Select one or more transitions on the storyboard. For multiple 
transitions, Ctrl-click on each transition one-by-one; for all 
transitions, right-click any transition, and select Select all transitions. 

2. Click  Transition Gallery on the context toolbar. 

3. From the dialog, choose a category from the upper window. In the 
lower window, review the presets available (their names indicate their 
intended function). Select a preset, e.g. 3D Page Roll. 
 

 

4. Click OK. 

 Alternatively, display the Galleries pane, select the Transitions 
gallery and a tab, then drag and drop your chosen preset onto your 
existing transition. Each preset stores popular settings for the 
transition type. 
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 Hover over any preset to see a preview of how your transition will 
look! 

To modify a transition: 

1. Select the transition thumbnail. 

2. From the Properties pane (General tab), alter the transition's 
Parameters. 

To delete a transition: 

• Simply select a transition and press the Delete key. 

The result is simply a cut: the last frame of the previous clip is immediately 
followed by the first frame of the next clip. To reinstate the transition, enter a 
transition value other than 0.0s. 

To save a modified transition to a new name: 

• Click  Add to Gallery in the Properties pane (General tab). Once 
named, the transition appears as a new preset in the appropriate folder 
in the Choose Transition dialog or Galleries pane (Transitions gallery). 



 

 

Editing in Timeline 
mode 5 
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Timeline basics 

Introduction 

 Click Timeline to switch from Storyboard to Timeline mode. 

For more advanced projects (compared to simpler storyboard-driven projects), 
the timeline lets you organize all your video and audio footage on multiple 
tracks, sequence clips one after the other, add and edit adjustments, effects, and 
so much more. The timeline offers the equivalent of all the manual editing 
operations that traditional film editors need and it allows for post-production 
alterations. 

The timeline has two basic dimensions, height and length. Horizontal length 
relates to the duration of your project: your timeline has markings along a ruler 
to indicate the passing of time, starting with zero at the left of the timeline. Any 
clips added to your timeline will follow a playback sequence from left to right. 
You can position the start point for previews (or the point at which you'd like to 
perform an edit) using a vertical marker called the Time indicator—this shows 
on both the timeline and as a preview marker in the Video Preview pane. The 
height of the timeline is related to the number of video or audio tracks used—
you'll need to introduce more tracks if tackling advanced editing techniques 
including overlays, masking, blue/green-screening etc. 

We'll describe some terminology used for various parts of the timeline and your 
project so that understanding timeline operations becomes clearer. 
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(A) Counter, (B) Timeline ruler, (C) Chapter Point, (D) Marker, (E) Selection 
Start/End, (F) Time Indicator, (G) Video Clip, (H) Image Clip, (I) Audio Clip, 

(J) Transition, (K) Selected Keyframe, (L) Unselected keyframe, (M) Keyframe 
Strips, (N) Effect, (O) Adjustment, (P) Audio Track, (Q) Pin, (R) Video Track, 

(S) Video Group, (T) Overlay Track, (U) Applied Property indicator, (V) Mute 
indicator/button.   
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Timeline elements 

Counter 
The counter sits at the top-left of your timeline and shows you time at the time 
indicator. It uses the format set in the View menu's Ruler Units flyout. 

Timeline ruler 
The ruler runs along the top of the timeline and shows you the current time 
range for the visible part of your project. You can zoom in or out of the timeline 
using a mouse wheel to display more or less of your project timeline on screen. A 
single-click on the ruler will position the time indicator marker for editing or 
video preview. You can alter your ruler units using the View menu's Ruler Units 
flyout. The default setting of "Time and Frames" is in the format hh:mm:ss/ff, 
representing hours, minutes, seconds and frames (of video), respectively. 

Chapter point 
A chapter point is a type of marker that is used exclusively for disc creation. 
Each chapter point placed on your timeline defines the start of your chapters 
shown in your disc menu. 

Marker 
Markers act as guides on your timeline to indicate key time location or events 
that occur within your project. They can be labelled, positioned and navigated 
equally. 

Set Selection Start/End 
Selection markers set a start and end range on your timeline within which any 
encompassed clips will be either pre-rendered (for optimized preview 
performance) and/or exported to file, PSP, or iTunes (Apple devices). The 
markers apply to all clips, tracks and groups down the entire height of the 
timeline. Limiting your export range is ideal for sharing only a chosen section of 
the movie, rather than the whole movie. 

Time indicator 
The time indicator, the blue vertical line you can see spanning the height of the 
timeline and its ruler, is most easily thought of as your editing marker. It allows 
you to set a precise position for splits and trims, allows clips and keyframes to be 
accurately positioned on your project timeline, and can be used along the 
timeline ruler to play back a preview of your project from that point. You can 
also position your time indicator over the start/end of a clip then single-click to 
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set a precise time indicator position. The time indicator is also shown in the 
Video Preview pane to indicate your playback position during playback. 

Video/Image/Audio Clip 
A clip is a media element; an "object" you can place on a timeline track. Clips can 
also include Computer-Generated (CG) clips (backgrounds, text, and 
QuickShapes). It's important to appreciate the difference between clips, tracks 
and groups because MoviePlus will allow you to add effects, for instance, to each 
or all of them with differing results. 

Transitions 
A transition is a time-based change between two overlapping video or audio 
clips. This change can be a simple fade between clips or for video clips, a more 
visually dramatic 3D transition (blinds, flips, rolls), wipes, zoom or spiral 
transition. Square-ended transitions are automatic, while triangular-ended 
transitions are manual (by dragging the triangular handle). Any transition can 
be replaced with a different transition by dragging and dropping a transition 
preset onto the clip's blue transition bar. 

Keyframes 
Keyframes are points along a strip associated with a clip, track, or group's 
properties (adjustments, effect, or transition). The keyframe stores your chosen 
settings for use at a specific point of time along your timeline. Using more than 
one keyframe along a strip, MoviePlus automatically (and gradually) changes 
from one keyframe's settings to the next keyframe's settings as time passes 
between them. For example, for an opacity adjustment, a keyframe at time zero 
with a setting of 0% opacity followed by another keyframe two seconds later with 
a setting of 100% would cause a gradual "fade in" effect over a period of two 
seconds. The keyframes can have their properties modified in the Properties 
pane when selected, and can be moved along the timeline to different points. 

Keyframe Strips 
If you want to change an adjustment or effect over time, you have to switch on 
keyframes for that selected adjustment or effect from the Properties pane (Click 
Enable Keyframes). The keyframe strip is displayed directly underneath the clip, 
track, or group. 

 

 



Editing in Timeline mode 63

 

Adjustment/Effect 
If an adjustment or effect is to be changed over time, it is shown in your 
Timeline header, along with its keyframe strip that hosts added keyframes. There 
is no restriction on the number of adjustments or effects that a clip, track, or 
group can have. 

Video/Audio Track 
A track is just a straightforward combination of a single light-grey timeline-wide 
strip and its header. You can add multiple clips to a track by dropping a multiple 
selection from the Media pane onto your track's strip. The clips will be added to 
the timeline in succession with a default overlap. 

MoviePlus supports multiple audio and video tracks so that it is possible to 
compose more complicated projects with "layers" of video using fades to reveal 
underlying layers. 

You can apply video/audio effects and adjustments (like opacity, transform, 
volume, and pan) to tracks and groups, which will have a resulting effect on all 
the clips on that track or all the tracks in a group (or both), respectively; a clip's 
crop adjustment may also be shown. 

A Music Track is also provided for optional soundtracks. 

Video Groups 
Groups are not only a way of keeping complex compositions tidy—you can also 
restrict editing to selected tracks by placing them inside a Video Group. Effect 
Groups, for both Video and Audio, work in an identical way for global effect 
control. The View menu also has an option to Show Master Groups, a top-level 
group to allow you to mute, apply effects to, or alter adjustments for all video or 
all audio at once. 

Overlay Track 
The Overlay Track, shown on a new project's timeline, is used to host text 
captions such as movie titles as well as video overlays. Titles will be 
superimposed over underlying movie content. These are dragged from the 
Galleries pane (Text gallery). 
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Applied Property indicator 

On clips and track/group headers, a  Applied Property indicator provides a 
visual clue that the clip, track, or group has been previously modified (from the 
Properties pane). If the property is muted, the indicator shows in a paler colour. 
If the property changes over time, the indicator displays a red centre. 

Mute 
Any clip, track or group can be muted at any time during video preview, which 
excludes it from the composition. For example, you may want to temporarily 
switch off an audio track while you are editing and previewing the same track 
again and again. Equally, you may want to mute or “black out” a particular clip 
while testing your project. 

  For video or audio tracks (and groups and buses), muting is possible 
by clicking the respective Mute buttons on the object's header. For clips, use the 
equivalent buttons on the Properties pane. The entire track or selected clip will 
turn black to indicate its mute status. 

The track/group header also hosts a Mute indicator which displays in green 
(unmuted) or red (muted). 

 To keep the properties on permanent display, click the drawing pin in the 
header of your clip, track or group. Click again to hide. 

Adding and arranging tracks 
In Timeline mode, four tracks are displayed on the timeline by default; for video, 
an Overlay Track and Video Track; for audio, an Audio Track and Music Track. 
The empty Video Track and Audio Track will be used for a video and its linked 
audio clip (if present) when dragged from the Media pane. 

 The empty Overlay track can take text (as captions) or video (for 
blended video overlays). The Music track is for standalone audio 
clips, typically backing music. 
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To add extra tracks: 

• Choose Video Track or Audio Track from the Insert menu. The track 
is inserted directly above any selected track of the same type. If no 
tracks are selected, the new track is added to the top of the track order.  

 Use the Shift key as you insert to add a new track below any 
selected track rather than above it.  

To change the track order: 

• Drag the appropriate track header further up or down the stack of 
headers at the left of the timeline. You'll see a grey line between tracks 
and a place cursor where your track can be inserted. Release the mouse 
button to place. 
 

 

The above example reorders two simple video tracks (selected Video Track 3 is 
dragged to be placed above Video Track 2). 

Adding media files 
Media files show in your Media pane after copy, import, or capture (see Adding 
media files to your project on p. 22). Once present, it's a great idea to arrange the 
order of the files prior to adding them to the timeline (see p. 57). This avoids 
having to rearrange clips in bulk on your timeline itself. Once you're happy with 
the order you can add the media to the timeline. 
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To add media to the timeline: 

1. From the Media pane, either: 

• Click to select a single media file. 
OR 

• For multiple media files: 
 
Use marquee select (to lasso files under a selection region). 
OR 
Use Shift key and click (to select a range of adjacent files). 
OR 
Use Ctrl key and click (to select a range of non-adjacent files). 
OR 
press Ctrl+A (to select all files). 

2. Drag selected media onto your timeline. Multiple clips will be added 
one by one along your timeline. Tracks suitable to specific clip types 
will be offered.  

Where you drag your clips onto the timeline is relatively "freeform". However, 
video and image clips must be located on video tracks, and of course audio on 
audio tracks. 
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Selecting clips 
When you are editing your movie and have already added a range of media clips 
to your timeline, all your editing operations (including moves, trims, properties 
changes and other adjustments) are carried out on the selected object(s). So, let's 
cover how you go about selecting clips! 

The good news is that you can simply click on clips to select them. Whether it's a 
video, image, audio, or text clip, a click will outline it in orange to show you that 
it is selected. Track or group names (in the header) are also highlighted in 
orange. 

 

Clips obtained for your camcorder will have both a video and audio clip (as 
above left)—you'll see each displayed next to each other on the timeline. 
Selection of the video clip, will always select the audio clip, and vice versa. The 
linked audio clip below the video clip shows a dark-blue border when the video 
clip is selected. Although not actually selected, edits will affect it. 

 Selecting a transition (e.g., Cross-Fade) also highlights in orange. 

 When a video clip is linked to an overlay clip, the linked overlay clip 
show in pale-blue. 

Selecting multiple clips 

You can select multiple clips (including clips that are linked) on your timeline by 
three main methods: 

• To select non-adjacent clips, hold the Ctrl key down on your 
keyboard and click each clip you would like to include in the selection; 
Ctrl+click again to remove a clip from the current selection. 
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• To select adjacent clips on a single track, click a clip at one end of your 
proposed selection range, hold the Shift key down and click on the clip 
at the other end. All clips in between, plus the selected clips, are 
selected. 

• For marquee selection, hold your primary mouse button down and 
drag a rectangle on your timeline—anything touching (and also 
anything inside) the rectangle will become selected. 
 

 

To make your multiple selection a permanent feature of your timeline for 
continuous easy editing, you can create a Link as described in Arranging clips 
(see p. 70). 

Zooming, scrolling, seeking, and scrubbing 
To see more or less of your project at one time or to navigate your project, you 
can perform various operations along your timeline. 

Zooming 

The Timeline toolbar hosts a series of very useful tools for zooming your 
timeline. 

  To see more of your project in the timeline area, click the Zoom 
Out button or scroll your mouse wheel downwards. To see more detail on 
your timeline to make it easier to perform fine edits, click the Zoom In 
button or scroll your mouse wheel upwards. 

 You can use the zoom slider on your timeline as an 
alternative to using the Zoom buttons. 
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 To see your entire project within the available timeline area—simply 
click the Zoom to All button. 

 If your time indicator is out of view due to a zoom operation or 
playback of your project preview, click Scroll to Caret to jump to the time 
indicator's current position. 

Scrolling 

To scroll the timeline horizontally, hold down the Shift key while using your 
mouse wheel, or to scroll vertically, hold down the Ctrl key. 

 It's also possible to drag your time indicator to the left or right edge 
of your window to scroll previously hidden parts of your timeline 
into view. 

Seeking 

The Video Preview pane also helps with some seek operations. 

• The  Go to Start and  Go to End buttons let you jump to the 
beginning or end of your project, respectively. 

•   For fine tuning the position of the time indicator (i.e., 
frame stepping or frame advance), for instance to perform a trim 
operation at a specific frame of video, you can use the Previous Frame 
and Next Frame buttons. 

•  The Shuttle control allows you to vary the 
preview playback speed and direction by dragging from the centre 
point to the left (to reverse) or to the right (to fast forward). 

Your preview will update any time the time indicator is moved, so you should 
always use the preview in conjunction with your editing operations. 
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Scrubbing 

Scrubbing might seem an unusual term but it is an extremely useful feature! You 
may already know that clicking along the ruler above the timeline sets your time 
indicator's position. However, if you click and drag along the ruler, MoviePlus 
will preview your project at the speed of the drag—as your mouse passes along 
the timeline in either direction, the preview will show you the current frame. 
This allows you to pass your mouse over an area of the timeline to preview a 
specific section without starting and stopping preview playback. 

Arranging clips 
Arranging clips on your timeline is crucial to building interesting, more complex 
projects—typically to create a rich multi-track multimedia project with the most 
popular video editing techniques. 

Simple arrangement—clips following one another 

Transition between clips 

By default, when you add clips to your timeline you'll get a default cross-fade 
transition showing between each clip. This allows adjacent clips to "blend" into 
each other during playback. For more about transitions, see Applying transitions 
on p. 81. 

 

Cut between clips 

When you want one clip—a video or image—to directly follow on from another 
clip, they need to touch each other on the timeline with no space in between 
them. When one "scene" follows another in this way, it's often referred to as a 
"cut" although you don't need to get the scissors out to achieve it with 
MoviePlus. 
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To create a cut, simply drag clips along on the same track so that they are 
positioned next to each other. When two clips are close together, the one you are 
dragging will snap into place. 

Making one clip appear on top of another 

MoviePlus uses multiple tracks in a similar fashion to the way photo-editors 
(such as Serif's own PhotoPlus) use multiple layers. Many compositions are 
perfectly fine with one "layer" but you can introduce some interesting effects by 
layering your images or videos on top of each other. 

MoviePlus composes your video based on timeline content, working from the 
top downwards. If you have multiple tracks in your project with a full-size video 
on the top layer, it could well obscure all underlying tracks because you can't see 
through it... but if your top-most track (or clips on it) contains Images (with 
transparency), Background, QuickShape or Text clips with reduced opacity, 
resized video or images using a transform adjustment, video with a mask applied 
or a Chroma Key effect, you will be able to see through to underlying tracks. 

So, to make one clip an overlay appearing on top of other clips, add an 
additional video track (choose Video Track on the Insert menu), then place the 
video or image you would like to appear as an overlay on the top track. All tracks 
support images or video with transparency, and all tracks follow the same 
timeline, so objects are almost as easy to arrange when using multiple tracks as 
they are for single-track projects.  

For caption text superimposed on underlying video, you can use the default 
Overlay Track which can take any Title caption presets dragged from the 
Galleries pane (Text gallery). 
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Deleting clips 

Any selected clip on your timeline can be deleted by pressing the Delete key. 
Any accompanying linked clip will also be deleted, i.e. a video clip and its 
associated audio clip are removed simultaneously. 

Linking clips together for easy editing 

Automatically-linked clips 

When you add a video clip to your timeline, you will normally find that two clips 
are added to your timeline—one video clip and one audio clip, on an adjacent 
video and audio track, respectively. 

 

This is because the video file contained both an audio and video stream that 
MoviePlus has separated for you for editing purposes. Because these two streams 
came from the same location, MoviePlus automatically links them together. 
When clips are linked, edits to one of the objects will affect other linked objects. 
If you select your video clip and perform a split, for instance, the linked audio 
clip will split in the same place. 

When moving clips, any linked clips on different tracks will move to new relative 
locations on the timeline providing there is enough space on each track for your 
clips to relocate to. 
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Temporarily disabling Linking 

There are occasions where you may find the need to temporarily disable Linking, 
for instance when trying to trim clips that are part of a Link, discard an unwanted 
audio track (below), or copying a clip independently of its linked clips. 

 

Unlinking/linking media 

Linking operations can be carried out in several ways: 

• By clicking  Linking on the Timeline context toolbar. Ensure 
clips are selected. 
OR 

• Via right-click Link and Group> submenu (or via Edit menu). 

• Select Unlink to unlink the clips (or Unlink All to unlink all 
currently linked clips). 

• Select Link to establish a link between selected video and audio 
clip (if the clips are not already linked). 

• Choose Select Linked to select all clips that are part of the link. 

 MoviePlus lets you link between an unlimited number of clips, 
either on the same or across different tracks. 
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Unlinking/linking overlays 

Link overlays are used to associate a video clip with an overlay, e.g. a caption 
such as a movie title or credits, superimposed over your video footage. 

 

By their nature, overlays have to occupy a higher level video track above any 
given track. The overlay could equally be another video clip. 

By linking, you can keep control of your overlays when moving your video clip, 
as the overlay will move with it. The overlay can be moved independently, but 
will always move with your video clip while linked. 

Linking/unlinking operations are as described for Unlinking/Linking media 
described previously but by using equivalent Link Overlay and Unlink Overlay 
options instead (right-click and select Link and Group>). A Select Overlays 
option lets you locate and select a link overlay from its underlying clip; a Select 
Overlays Base option does the opposite. 

 Linked overlays show with a light blue border when selecting the 
underlying video clip. You can change the clip selection colours 
using the Editing options accessed from Tools>Options.... 

Grouping clips 

The selection of multiple clips allows you to move those clips around your 
timeline at the same time, but only while they remain selected. As a more 
permanent solution for dragging, copying, and deleting, grouping clips makes a 
connection between clips until you choose to ungroup them. The grouped clips 
can be moved together at any time, until ungrouped. 
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Grouping operations described below are provided in a Link and Group> right-
click menu, but are all also available from the Edit menu. 

• Group: Groups two or more selected clips. If you've got grouped files 
already selected, use Ctrl-click to select another clip to be grouped, 
then select this option. 

• Ungroup: Select a file already grouped, then choose this option to 
remove just the selected file from the group. 

• Ungroup All: Click any grouped file then select this option to ungroup 
itself and all other files that are grouped. 

• Select Group: Selects all clips that are part of your group. 

 Groups are ignored when trimming—you'll be able to trim clips 
without affecting the grouping. 

Grouped clips show on your timeline with a dark blue border; the selected clip, 
being part of the group, will show with an orange border. 

 

 You can change the clip selection colours using the Editing options 
accessed from Tools>Options.... 

Aligning frames 

The Align To Frames option on the Arrange menu will enable and disable 
snapping to the nearest frame of video. Video frames are typically about 30 or 40 
milliseconds apart (there's typically 25 or 30 frames per second of video), so you 
can choose whether your Time indicator-based editing snaps to these divisions 
or is totally freeform. Frame snapping, or align to frames, is the normal mode to 
work with unless you are trimming audio to a very fine degree. 
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Rippling 

 Rippling is a design aid that takes some of the headache out of making 
room on your timeline, or taking up slack (empty) space on the timeline by 
keeping your clips' relative positions constant when you make edits (this also 
includes a clip's keyframes). Rippling saves you the effort of moving multiple 
clips for the sake of what is often a minor edit, perhaps to make room at the start 
of your project for titles or a new intro or the deletion of a section of video from 
the middle of a project. You can enable and disable Rippling using either the 
Rippling button on the timeline's context toolbar, or by using the command on 
the Arrange menu. 

Moving clips 

Rippling affects other clips (and their adjustment, effect or transition's 
keyframes) starting at the same time or after the clip you are moving. When you 
move a clip, those other clips that start at the same point or later on the timeline 
will automatically shuffle left or right to account for your move. 

When trimming or extending the end of a clip 

Rippling only affects other clips that both start after your edited clip starts and 
end after the end of your edited clip. 

When trimming the start of a clip 

Rippling affects other clips that start and end after the start of your edited clip, 
and it also moves your edited clip to the same "start time" it had before you 
trimmed its start, shuffling other affected clips at the same time. 

Ripple mode 

 Rippling can be set to work in one of four modes: it can affect the track 
you are working on, all tracks of the same level (e.g., those within a group), all 
tracks on the same level including marker rippling, or the whole timeline (with 
marker rippling). The last two options allow markers to maintain their positions 
relative to the moved clips—otherwise marker positions will not alter when 
rippling takes place. 
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Rippling with complex projects 

For complex multi-track projects, you might worry that Rippling won't manage 
all the necessary moves—don't worry, Rippling works regardless of the number 
and type of clips or tracks involved. Providing you have selected the appropriate 
Ripple mode you can move a large number of clips that span multiple tracks by 
having Rippling enabled. Be sure to select an appropriate timeline zoom level 
when selecting and moving your clips—you may wish to use a low zoom level (to 
see all of your project) to make the move easy, but you might find that using a 
higher zoom level (seeing just a few small clips) allows you to more easily select 
and drag the correct clip. MoviePlus will automatically scroll the timeline in the 
direction of your drag until you centre your mouse to choose a "drop zone", but 
you could instead type a new start time for your selected clip in the Properties 
pane—Rippling works however a clip is moved. 

Snapping 

Snapping is a design aid that helps you achieve neat layouts. When you are 
moving objects around on the timeline (or trimming/stretching them), snapping 
makes your edit jump to the nearest clip, to the position of the time indicator, to 
the beginning of the timeline, and to a default transition overlap value. 

By default, snapping is enabled, although you can switch it off from the Arrange 
menu. To control which elements do and do not get snapped to, or to adjust 
snap sensitivity, select Tools>Options (Snapping menu option). Hold down Alt 
during your editing operations to temporarily switch snapping off (or on, if 
disabled). 

Using groups 

Video groups 

Video groups serve a couple of important functions on MoviePlus's timeline. 
Firstly, they can help keep related tracks together for easy management. For 
instance, applying an effect to a video group means that all tracks within the 
group inherit the effect. 
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Video Group 1 contains Video Track 1 and Video Track 2 (but not the 
Background Video track). The Adjust HSL effect has been applied to the Group 
(and therefore Tracks 1 and 2 simultaneously). Background Video is not subject 
to the effect. 

The next main function for video groups is more complicated but very useful, 
i.e. limiting the range of a transparency effect or mask. Masks and the Chroma 
Key effect are both methods of achieving transparency (see p. 99 and 103). 

To add a video group: 

1. Select the video track above which you want to insert a group. 

2. Choose Video Group from the Insert menu. 

Once you've created a group you have to then associate chosen tracks to the 
group. 

To add a track to a group: 

• Drag and drop the track over the group header. 
 

 

The track will be nested under the group if the operation is successful. 

To drag a track out of a group, aim to drop the track at the bottom edge of the 
group or any header position that is as wide as the group's header. 
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If using video groups, click the  Expand/Collapse button to collapse the 
group's tracks, adjustments, or effects. 

 

Applying opacity to video groups 

You can adjust the opacity of a video group in two ways—either uniformly by 
adjusting the group's Opacity slider in the group’s Properties pane, or over time 
by adjusting the group's opacity on the Timeline using the adjustment's 
keyframes. For the latter, see Changing properties over time on p. 86. This will 
allow you to fade the result of an affected section of video organized within a 
group, for instance, or to make a series of still image overlays appear 
translucent—without having to edit each clip or track in an identical way. 

Transforms—perspective, scaling, and motion 

You can apply transforms, such as perspective effects, resizing, or animated 
motion, to video groups. Such an effect would allow for the composite result of a 
group to be used as an inset video, for instance. To learn how to edit a transform 
adjustment, see Changing properties over time on p. 86. 

Master groups 

Show Master Groups in the View menu lets you affect all the video groups and 
video tracks separately but in one fell swoop. For example, you could apply a 
video effect to the entirety of the video in your project by applying it to the 
master group. 

When created, a Master Group appears in your timeline header region and 
contains all your tracks. 
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 The audio equivalent of a Master Group is called the Master Bus, 
which influences all audio buses in your project. See Using audio 
buses on p. 137. 

Video effect groups 

Video effect groups are not used frequently but are essential if you wish to blend 
affected and unaffected video. The affected video would have cumulative effects 
applied, which could be blended in and out of the mix by adjusting the keyframes 
of the Video Effect Group. See Changing properties over time on p. 86. 

Audio effect groups 

These are the audio equivalent of video effect groups, and operate in the same 
way as them. They are used for mixing between audio and audio effects.. 

Splitting clips 
The Trim option in the Media pane allows you to split a clip into separate scenes 
before adding to the timeline. However, you can still split any video clip once on 
the timeline at the currently set time indicator's position. 

Splitting a clip into two lets you insert another "filler" clip in between each split 
clip. You can perform multiple splits to create distinct sections of your clips for 
deletion. 

To split a clip: 

1. Select the clip you would like to split. 

2. Position the time indicator on the ruler at the point in the clip where 
you'd like to make the split. 

3. Click  Split on the Timeline toolbar (or use the S key on your 
keyboard). 

  If you have no clip selected, all clips across all tracks are split 
simultaneously at the time indicator. 
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Applying transitions 
Any time one piece of video ends and another begins, a transition takes place. In 
its simplest form, the transition is simply a cut: in less than the blink of an eye, 
the last frame of a clip is replaced by the first frame of a second clip. 

In MoviePlus, the term “transition” applies to a more gradual way of switching 
from one clip to another. If you add multiple media files from the Media pane or 
overlap two clips slightly on the same track, you get a time-based change 
between them, shown as a blue region (as indicated below). An In transition 
called "Cross-Fade" is added by default to the second clip. 

For audio, an equivalent transition is added to fade the audio from the first to 
the second audio clip. 

 

 The default Cross-Fade and Fade transition types have no associated 
properties. However, all other transition types have associated 
properties, which can be modified at any time. 

Changing transition type 

MoviePlus offers an impressive selection of transition types that you can swap 
your default transition for. Types range from 3D blinds, bands, wipes, and fades, 
to slides, spirals, and more. 
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To change transition type: 

1. Select one or more transitions on the timeline. 

• For specific transitions, Ctrl-click on each clip's transition region 
one-by-one. This can be carried out across multiple tracks if 
needed. 

• For all transitions on a single track, select any single transition on 
the track, then press Ctrl+A. 

• For all transitions across multiple tracks, select a transition on 
each of the tracks (with Ctrl-click), then press Ctrl+A. 

2. Click  Transition Gallery on the context toolbar. 

3. From the dialog, choose a category from the upper window. In the 
lower window, review the presets available (their names indicate their 
intended function). Select a preset, e.g. 3D Page Roll. 
 

 

4. Click OK. 
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The Transition name(s) changes, e.g. from "Cross-Fade" to "3D Page Roll": 

 

 

 

The end of the first clip is indicated by the vertical dashed red line. 

 For an alternative way to replace transitions, display the Galleries 
pane (Transitions gallery) and a tab, then drag and drop a transition 
thumbnail onto your transition (this could be on the transition strip 
or region). 

Manual transitions 

Another type of transition is a manual transition, which can be either an In 
transition or Out transition. They are created manually at the start or end of a 
single clip, respectively. The former can be useful as a fade-in on the first clip at 
the start of a track (first example below). Conversely, an Out transition can be 
applied to the last clip in any track as a fade-out (second example below). 

 

 

In Transition Out Transition 

You may have noticed that the above transition region's shapes are different 
compared to previous examples. The arrow-shaped regions indicate manual 
transitions—the arrow is actually a handle to drag left or right to adjust the 
transition's duration. 
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To change a manual transition's duration: 

Drag the left or right-hand end (as shown below) of the transition region to stretch 
or shrink it, or specify an absolute value in the transition's Properties pane. 

 

Remember that each transition takes time to happen—so make sure the video in 
the overlap region is not part of the main action. If you expect to use transitions, 
it’s a good idea to allow a couple of seconds of non-essential material at the start 
and end of clips when you initially capture them. 

 The duration of Automatic transitions is altered automatically by 
moving either clip on the timeline. 

 You can also modify the transition duration of one or more 
automatic or manual transitions using the Properties pane's 
Duration option. 

Modifying transitions 

Transitions added to your project will have their own set of properties associated 
with them. These are highly customizable via the Properties pane, just like any 
other object in MoviePlus. Try selecting a transition region and check its 
properties in the Properties Pane. 

The ability to customize transitions by changing these property settings means 
that the presets supplied are merely a starting point for you to further create and 
save your own transitions to your own requirements. 

To modify a transition: 

1. Select the transition region. 

2. From the transition's Properties pane, alter the transition's parameters 
at the bottom of the pane. 



Editing in Timeline mode 85

 

To save a modified transition to a new name: 

• Click the  Add to Gallery button at the top of the Properties 
pane. Once named, the transition appears as a new preset in the 
appropriate folder in the Choose Transition dialog or Galleries pane 
(Transitions gallery). 

Overlaps 

The overlap is the region in between overlapping clips where the transition will 
be visible. It is the area between the start of the second clip and a red vertical 
dashed line indicating the end of the first clip. 

 

Overlap control is especially useful when creating photo slideshows in 
MoviePlus. Even though your added clips will have a set overlap shown between 
them, you can modify an individual or selected clip's overlap easily. 

To change the clip overlap: 

1. Select the clips on your track(s). 

2. From the Timeline context toolbar, enter an Overlap value. 

 Changing the overlap doesn't affect the clip duration but will affect 
the clip's position on the timeline if rippling is enabled. 

 If you want to use a specific overlap value for all clips, try setting the 
Overlap value before dragging media onto your timeline. All clips 
will adopt the currently set overlap. If you set an overlap of zero in 
advance you'll add clips without automatic transitions. 



86 Editing in Timeline mode 

 

Snapping 

If Snapping is enabled (Arrange menu), the transition will conveniently fit into 
the overlap region. If snapping is disabled, or you drag the transition to an 
overlapping area between tracks, it will adopt a default overlap time as set in 
Tools>Options>Editing. Any applied transition should always match the 
overlap region, i.e. where two clips are co-existing on the timeline. 

When snapping is enabled, your clips will be "sticky" when you drag clips near 
the default overlap period (MoviePlus offers a 1-second sticky overlap point by 
default). This makes it easy to keep a standard transition duration throughout 
your project without manually editing each transition duration in the Properties 
pane (or very carefully dragging your clips) for each overlap; MoviePlus uses 
standard values which you can alter in the Tools>Options>Editing dialog.  

The overlap value is also used as a default transition duration when you add 
multiple image clips to the timeline simultaneously—great for making quick 
slide shows! 

Changing in/out transitions over time 

You can make an In or Out transition change with time over the duration of the 
transition region only. This is done by using keyframes, each possessing their 
own properties, which affect the clip from that keyframe position onwards. 

Changing properties over time 
Changing properties over time allows the video editor to make the most of the 
professional and creative capabilities of MoviePlus. There are many reasons why you 
would want to do this, but some typical examples are outlined in the following table. 

Uses Adjustment Property Type 
Video panning across a scene. Crop Adjustments (video) 

Blending video between tracks  Opacity Adjustments (video) 

Perspective, Picture-in-picture 
effects, Zoom ins, Spinning, and 
Scaling. 

Transform Adjustments (video) 

Adjusting white balance. Colour Adjustments (video) 
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Correcting bad exposure in video 
when moving camcorder from 
shadow to strong light. 

Lighting Adjustments (video) 

Blending between audio tracks. 
Fade up (down) audio at the start 
and end of clips or tracks. 

Volume Adjustments (audio) 

Shifting audio between left and 
right channels. 

Pan Adjustments (audio) 

Animating a mask for creative 
effects. 

Mask Effect 

To overcome lighting conditions 
that affects the colour you're 
trying to remove. 

Chroma keying Effect 

Customize in and out transitions 
on overlapping clips for advanced 
effects. 

Transitions Transitions 

Mixing between video clip and 
effects. 

Video Effect 
Group 

Group 

Audio mixing between audio clip 
and effects.  

Audio Effect 
Group 

Group 

Keyframe strips and keyframes 

Keyframe strips and keyframes are used to change a clip, track or group's 
properties over time. Imagine a keyframe strip as a hidden "track" that runs 
along with each clip, track, and group; at specific times you determine how the 
properties change by adding configurable keyframes. Keyframes store 
information about the property you are editing.  

Two different types of keyframe strip are used in MoviePlus to allow properties 
to change over time. 

Adjustments - Simple 
(Opacity, Volume, 
and Pan) 

These single-parameter adjustments can be 
changed using a thick strip as there is only one 
parameter to be altered. This lets you position 
buttons (called keyframes) in the vertical axis. 
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For example, for an opacity adjustment: 
 

 
 
Each keyframe defines the level of opacity by its 
vertical position in the keyframe strip. 
 
You can apply the same principle to video groups 
and audio effect groups. 

Adjustments - Multi-
parameter 
(Crop, Transform,  
Noise Reduction, Colour, 
Lighting, Stabilize, and 
 any effect or transition) 

If the property possesses multiple parameters, those 
settings can't be easily represented independently on 
the timeline. Therefore, the keyframe strip just 
appears as a thin strip stretching the duration of the 
clip, track or group, leaving the Properties pane to 
take on the configuration role. 
 
For example, for a Crop adjustment: 
 

 

Showing keyframe strips 

When you add an adjustment or effect to a clip, track or group, you'll need to 
show a keyframe strip if you want to change the property over time. 

To show a keyframe strip: 

1. Select the clip, track or group. 

2. From the Properties pane, select the adjustment or effect you want to 
change over time. 

3. Click  Show Keyframes. A keyframe strip is revealed as a white 
area; a single selected default keyframe ( ) shows at the start of the 
keyframe strip. For a clip, the keyframe strip shows directly under the 
clip (for the clip's duration only). For a track (or group), the keyframe 
strip extends the length of the timeline. 
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Each adjustments, effect, or transition, on selection in the Properties pane, is 
shown in its own keyframe strip. 

Deselecting your clip, track or group will automatically hide your keyframe 
strip. To display again, select the clip and its modified property (e.g. an 
adjustment) in the Properties pane.  

 For permanent display of the strip, click the  pin icon in the 
clip/track/group header. 

 When you move your clip its keyframe strip also moves in 
synchronization. 

 You can enable a keyframe strip for a transition using the same 
method. 

Selecting keyframes 

A keyframe, when selected, allows you to modify its properties via the Properties 
pane. The first keyframe you see in the keyframe strip will be selected by default 
(shown red). 

 

A keyframe can also be grey ( ) if it is unselected (by clicking away from it), but 
will revert to red on selection again. 
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Adding keyframes 

To make changes to properties over time, you have to add and subsequently edit 
keyframes along the keyframe strip. 

To add a keyframe: 

1. (Optional) Position your time indicator for accurate keyframe 
placement. 

2. Hover the cursor along the object's strip until it changes to the Add 
cursor ( ), then click to add the keyframe.  
 

 

3. Repeat to add further keyframes. 
 

 

  When you add a keyframe, your clip, track, or group will display 
a red button on its Applied Property indicator. 

 Any added keyframe adopts the properties of the keyframe 
immediately preceding it on the timeline. 

Deleting keyframes 

To delete a keyframe: 

• Select the keyframe and press the Delete key.  

Modifying keyframes 

For some simple properties such as opacity, pan and volume adjustments, you 
have to add and edit keyframes as above and then drag the keyframe up or down 
to adjust the keyframe's properties directly. These keyframe strips are designed 
to have more depth for this reason, e.g. for fade-in (or fade-out) on opacity and 
volume adjustments. 
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To modify keyframes for simple properties: 

• Move the keyframe up or down within the keyframe strip. 
 

 

 

In this example, an opacity adjustment on a video clip fades the clip in over time. 
The lower the vertical position of the keyframe in the strip the less the opacity 
setting. MoviePlus calculates the rate of opacity change from the line between 
the keyframes. 

For more complex properties, e.g. for Crop, Transforms, Effects, and Transitions 
a narrower strip is provided. The individual keyframe represent multiple settings 
for the property rather than just one. 

To modify keyframes for more complex properties: 

• Select the keyframe then edit its properties in the Properties pane. 
 

 

Moving keyframes 

You can move one or more selected keyframes left and right along the strip 
which has the effect of moving them earlier or later along the timeline. For more 
precision, you can also use the Keyframe time option in the Properties pane. 

Navigating keyframes 

• Use the Ctrl+< and Ctrl+> keyboard shortcuts to Select Previous 
Keyframe and Select Next Keyframe on a strip. 
OR 

• Use the  Select Previous Keyframe or  Select Next 
Keyframe in the Properties pane. 
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Advanced 

More advanced keyframe control is possible including copying and scaling 
keyframes, altering the rate of change between keyframes, and repositioning of 
keyframes. For more details, see online Help.  

Using markers 
Markers have several uses in MoviePlus but are always added along the top of 
your timeline at the current time indicator. Three types of marker are available: 

 Marker 1 
(green) 

Basic marker 
Used as simple reference points, to indicate important events 
occurring at key times in your movie, e.g. sound or action, or 
to mark the start and end of clips on more complex multi-
track projects (for positioning and arranging). 

 Chapter 1 
(blue) 

Chapter point 
For use exclusively when creating menus for discs, they exist 
in two forms—standard or Top Level; The former define the 
beginning of chapters on any menu; the latter, the chapter 
points on the Top Level menu only (see Menu Designer: 
Editing chapter properties on p. 182). 

 Selection 
Start (blue) 

 Selection 
End (blue) 

Selection markers 
Define a time range for selective pre-rendering or to export 
only part of your MoviePlus project (to file, PSP, or iTunes). 

 Markers of any type are coloured orange on selection. 
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Adding markers 

Markers of any type can be added at any point on your timeline—they can be 
labelled, repositioned by dragging, as well as navigated. 

To insert a marker: 

1. Click on the timeline ruler to set the time indicator's position. 

2. From the context toolbar's  Marker drop-down list choose: 

• Insert Marker. 
OR 

• Insert Chapter Point. 
OR 

• Set Selection Start (or End). 

By default, markers will be named according to type, i.e. Marker 1, Marker 2, 
Chapter 1, Chapter 2, Selection Start, etc. 

To rename your marker: 

• Go to the selected marker's Properties pane and edit the Name field. 

To select a marker: 

• Click the marker box (whether a basic marker, chapter point, or 
selection marker) on the timeline ruler (use Ctrl-click to select 
multiple markers; or Ctrl+A to select all markers). 

To delete a marker: 

• Click on the marker and press Delete. 

Navigating markers 

If you're working on a long timeline you may need to navigate your markers so 
you can check that each marker is of the correct type and position. The 
navigation method is the same for any marker type (basic, chapter point, or 
selection marker). 
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To navigate markers one by one: 

• With any marker selected, use Ctrl+Shift+left or Ctrl+Shift+right 
arrow keys. 

To navigate markers via dialog: 

• From the context toolbar's  Marker drop-down list, select Go to 
Marker... to select from markers (of any type) listed in a dialog. 

Using chapter points 

Chapter points are a type of marker used to define where chapters play from in 
your generated disc—much the same as the initial menu shown in any movie 
DVD from your local movie store. When you decide to create your disc, these 
named chapters will be shown as menu thumbnails that can be clicked to play 
the movie from that point. 

In the Menu Designer, chapter points inserted in your timeline will be detected 
and the associated chapters will be thumbnailed automatically (see Menu 
Designer on p. 178). 

As an example of chapter points on the timeline, a holiday movie could have 
named chapter points which represent key points on the movie, e.g. Castle, 
Dolphins, Flamingo, etc. 

 

Using multi-level menus 

MoviePlus supports multi-level menus, where you can store your main "title" 
chapters on the top-level menu (first page) while subsidiary chapters can be made to 
appear on a secondary menu (second page). For the former, select Top Level in the 
Properties pane for any chapter point you want on the top level. Any other chapter 



Editing in Timeline mode 95

 

points (with Top Level unselected) appear on the secondary menu. Optionally, add 
alternative text that will display next to your menu's thumbnail label. 

The timeline (for a single-level menu) would look slightly different for a multi-
level menu. Chapters could be left unnamed, with top-level chapter points 
defined on the timeline (indicated) for key portions of your movie (e.g., Play 
Movie, Week 1, Week 2). 

 

The results would be a top level menu which plays from the beginning (Play 
Movie) with additional Week 1 and Week 2 options to click for chapters on 
secondary menus. 

 

 On the timeline, top-level chapter points are slightly bigger ( ) 
compared to standard chapter points ( ). 

  In Storyboard mode, chapter points can be inserted at the start 
of any clip by clicking the thumbnail's Chapter Point button. 

 If you want to convert a basic marker to a chapter point, simply 
select chapter point in the selected marker's Properties pane, and 
set the additional chapter point options as required. 
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Inserting multiple chapter points 

As well as inserting chapter points by hand (see Using markers on p. 92) you can 
add multiple chapter points at regular intervals along your timeline. This is a 
great way to set up lots of chapter points initially, moving individual chapter into 
position, or deleting unwanted ones as you edit. To insert, use the Multiple 
Chapter Points option (Insert menu), choosing an interval duration. 

If you want to keep existing chapter points, ensure Delete existing non-title 
chapter points is unchecked. If checked, all non-title chapter points are 
removed. You also have the option to Renumber existing chapter points. 

Renumbering chapter points 

If you've rearranged your unnamed chapter points, your chapter point numbers 
may get out of sequence (Chapter 3, Chapter1, Chapter 2, etc). To remedy this, 
use Renumber Chapter Points (Edit menu) to renumber them in play order, i.e. 
Chapter 1, Chapter 2, etc. 

Using selection markers 

Selection markers differ slightly from basic markers and chapter points. Instead, 
they work in pairs to set a time range on your timeline within which MoviePlus 
can perform operations limited to that set range. Operations include: 

• Pre-rendering part of the timeline that contains complex MoviePlus-
applied effects and transitions, for improved preview playback. 

• Exporting a part of your movie by setting an export range. Used for 
exporting to file, PSP, or iTunes. 

To limit to a specific time range: 

1. Click on the timeline ruler to set the time indicator's position. 

2. From the context toolbar's  Marker drop-down menu, choose 
Set Selection Start (or right-click on the time indicator) to set the start 
of your time range. From the same menu, select Set Selection End to 
set the end of your range. 

3. (Optional) Drag your Selection Start and Selection End markers 
along the timeline to fine-tune your time range. 



Editing in Timeline mode 97

 

Once set, any pre-rendering or exporting will be limited to the chosen time 
range. Pre-rendering is carried out with the Pre-render Selected Range option 
(Preview menu). 

Slowing down and speeding up 
Video clips can be slowed down (slow motion) or speeded up by decreasing or 
increasing the Play speed on the clip's Properties pane (General tab). You'll see 
the duration change on the chosen clip as you adjust this value—when a video 
plays slower or faster, it has a longer or shorter duration, respectively. 

On the timeline, you can still adjust the Play speed as described above but to 
increase or decrease the play speed, hold the Ctrl key down and drag an edge of 
your video clip inwards or outwards, respectively.  

 

Transparency & opacity 
Transparency and opacity are intrinsically linked, like different sides of the same 
coin. Opacity means a state of being opaque—you cannot see through a video or 
other clip to those underneath if it is totally opaque. By contrast of course, you 
can see through video that is partially or wholly transparent, or has regions that 
are partially or wholly transparent, with no opacity. 

 

 

 

Text clip over video clip 
(90% opacity)  

Text clip over video clip 
(60% opacity) 



98 Editing in Timeline mode 

 

MoviePlus generally refers to opacity rather than transparency, but you should 
keep both concepts in mind during your editing to help understand various 
features such as Chroma Key (matting/blue screening) and masks. 

Let’s firstly take a look at different ways in which opacity can be used on whole 
clips, tracks, groups and effects in MoviePlus. A general level of opacity can be 
applied to: 

• a clip, to allow you to "fade" video or images in and out of vision over 
other video clips. 

• a whole video track, to make a collection of clips more or less visible. 

• a video group, so that the composite result of a collection of grouped 
tracks can be made less or more visible as part of the overall 
composition. 

• a video effect group (i.e., allowing mix back to blend original with 
affected video). 

For all of the above, an opacity adjustment is used to set a constant level of 
opacity. 

A specific region of transparency or opacity can be created for: 

• Removing a solid-coloured background (also called blue- or green-
screening). This is achieved using a video effect called Chroma Key. 

• Creating a cut-out region, using a mask. 

• Creating a limited region for an effect to be applied over, e.g. only 
applying a mosaic effect to a subject's face rather than the whole video, 
also using a mask. 

• Cropping using a mask. 
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Changing properties over time 

A powerful feature of MoviePlus's Timeline mode is the ability to change opacity 
over the clip's playback duration. This is done by using keyframes, placed under 
the clip on the timeline. Each keyframe possesses its own properties, which affect 
the clip from that keyframe position onwards. Tracks and groups can be affected 
similarly. For more details, see Changing properties over time (p. 86). 

Removing Backgrounds 
There are a number of reasons you might want to "remove" a region of your video: 

• To isolate a foreground subject in order to place them against a 
different background, e.g. blue-screening such as used for movie 
special effects and daily favourites like weather presenting. 

• To cut out a hole in a video, e.g. a billboard advertising area or sports 
stadium big screen, in order to place a video of your own in the cut out 
region. 

• To limit the extent of an effect e.g. to just mosaic someone's face to 
respect their privacy but leave the remainder of the video unaffected. 

• To crop your movie, e.g. leave just a rectangular or other-shaped 
portion of your video and discard the remainder, perhaps leaving 
room for other cropped videos on screen to sit alongside to form a 
montage, popularized by comic book hero movies. 

The cutting out of regular shapes and cropping of video is something you can 
achieve using masks. The removal of a solid-coloured background can be 
achieved using a Chroma Key effect, also called blue-screening/green-screening, 
matting, colour keying and colour separation overlays. 

Masking 
Masks are a way of using an image to "cut out" a rectangular or other-shaped 
portion from a video, leaving transparency around the subject, effectively 
removing a background to give focus to a foreground element. You can also use 
masks to crop video for multiple picture-in-picture effects. Masks can also 



100 Editing in Timeline mode 

 

remove a foreground element to reveal another video or image clip through the 
cut-out region. 

Masks as used in MoviePlus are best created as transparent images with a white 
region to indicate the shape of underlying video to keep; the white region is like 
the inside shape of a cookie cutter, the transparent region is discarded like the 
outlying pastry around your cutter. You can also use images that contain a 
mixture of different colours and transparent regions for advanced masking. 

In addition, QuickShapes let you apply shaped masks directly onto the timeline 
with no fuss. See Using CG clips on p. 166. 

 You can create your own masks with Serif PhotoPlus. 

 

Original video. 
  

 

  

 

The Text clip (with added QuickShape) 
is placed on a higher video track 
(renamed Mask Track), which has a 
Mask blend mode.  

 

 

 

Resulting composition only has the 
mask-shaped region showing video 
content. 
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Video tracks 

Before you go ahead and add a mask to your timeline, it's useful to know in 
advance how masks and the organization of your video tracks work together. 
Masks need to occupy a track of their own to have an effect on underlying video 
compositions... the mask's white regions determine which regions of underlying 
video clips you see—the mask sits on top of other video clips to act as a virtual 
cookie cutter. 

Using the Mask blend mode 

Masking is made possible by the correct arrangement of tracks (as described 
above), but also by the setting of the Mask track's Blend Mode in the General tab 
on the Properties pane. When set to "Mask", the Blend Mode on the top-most 
track in your project will affect transparency on tracks below it. 

 

Restricting mask effects within video groups 

To limit which tracks are affected (the depth to which the cookie cutter actually 
cuts), you can store the mask track with blend mode applied (and other video 
tracks you want affected) within a Video Group, leaving other video tracks you 
do not want affected outside the group. 

Looking at the track names in the example below, "Background Track" is not 
subject to the clipping that the Mask Track is performing because it is outside 
the video group—the mask's effect is limited to tracks within its video group, i.e. 
the Main Track only. 
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The Main Track footage is masked 
as it is in the same group as Mask 
Track; Background Track footage is 
kept outside Video Group 1. 

 

  

 

The mask only cuts out content 
from the Main Track. The 
underlying video, outside of the 
video group, is unaffected by the 
masking operation! 

Creating your own masks 

To create a mask it is recommended you use a bitmap (photo) editing program 
that fully supports transparency, such as Serif PhotoPlus. Some other programs 
that can easily create shapes with or without soft edges (and can export images 
with transparency, such as 32-bit PNG) are also useful for creating masks—Serif 
DrawPlus is an example. 

You should aim to use white to create the region you wish to maintain in your 
video, and transparency for the areas you wish to cut away. Partial transparency 
is supported, so you can create regions of translucency as well as using a mask to 
create solid regions of opacity and transparency in your video. 

To add your own masks to your project, browse to their saved location using the 
Media pane, and drag your mask image onto a track of its own, positioned above 
the video you would like to mask. 
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Once in your project, you can also stretch your mask to fit using Stretch from 
the Fit drop-down menu on the Timeline context toolbar. Alternatively, you can 
always adjust size and position using a transform adjustment (see p. 37). 

Blue/green screening (Chroma Key) 
This process, referred to as Chroma Key in MoviePlus, enjoys a few other names 
including colour keying, matting, and colour separation overlay. It is a method 
of removing a colour (or a colour range) from one video or image to reveal 
another video or image behind it. The "removed" colour becomes transparent. 

This process is commonly used for weather broadcasts and of course in many 
movie blockbusters. To start with, the foreground subject—a weather presenter 
for instance—is filmed against a solid-coloured and evenly-illuminated 
backdrop. Using MoviePlus (or expensive studio wizardry in the case of live TV 
weather slots), the solid coloured region of this video can be made transparent 
using a Chroma Key effect, revealing an underlying video. In the case of some 
weather presenting, the video "behind" the presenter can show a weather map 
with animated symbols or weather systems. In movies, the process saves actors 
being put in dangerous positions, such as visually-stunning explosions, or in 
places that cannot be reached for practical or budgetary reasons, such as across 
the other side of the globe or in space. 

It's not only a background that can be removed; you can, for instance, hold up a 
solid-coloured card while being filmed and later remove that solid colour from 
the video to create a card-shaped cut-out. The alternate "background" video 
would then display through this "hole". 
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Blue screening in action 

 

Simple blue-screen filming of a 
"skiing" family against a solid-
coloured background (e.g., a 

blue studio backdrop). 

 

Background video, placed on the 
track below the blue-screen 

footage on the timeline. 

 

The upper video clip on the 
timeline, the blue-screen 

footage, has had a Chroma Key 
effect applied to it. Properties 

sliders were adjusted to remove 
all the blue. 

Applying the Chroma Key effect 

Effects in MoviePlus can be applied to individual video clips, whole tracks, or 
video groups. While Chroma Key can also be applied to all three hierarchies, it is 
most commonly used with individual video clips, as it is not usual for there to be 
multiple clips with the same background colour to be made transparent. 

The effect is applied like any other video effect, by clicking Add Effect... on the 
Properties pane (see Applying video effects on p. 113). 

The Chroma Key effect will automatically remove whichever colour is associated 
with the Chroma Key effect applied to your video. You'll probably need to 
"sample" the colour that appears in your clip for best results. 
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To change the Chroma Key colour: 

1. Select the effect in the Properties pane's Effects list. 

2. Use the  Colour picker to select a new Colour value from the clip 
that you want to remove (hold down the mouse button, and drag the 
picker over the colour you require, and release). This would normally 
be the backdrop colour. 
OR 
 
Define a new colour by clicking the Colour spectrum and, from the 
Adjust Colour dialog, select an RGB, HSL or HTML code. 

Changing thresholds and blurring 

MoviePlus lets you fine-tune the Chroma Key effect to help the colour-detection 
processes determine which bits of your video to make transparent. It is very 
useful to be able to set a Low and High threshold for colour detection—this 
transparency is set according to brightness levels. Blur lets you blur the shape of 
the transparent region generated by the Chroma Key effect. 

Applying colour pass 

The Colour Pass check box lets you select a specific colour to be retained in your 
video clip, while removing all other, leaving the picked out colour against a 
greyscale background. 

Introducing 2D and 3D transforms 
In Timeline mode, transforms are a powerful tool in the video editor's arsenal. 
Transforms are a type of adjustment attached to a clip, video track, or video 
group. They allow video, image, and CG clips (Backgrounds and QuickShapes) 
within your overall project to be changed in size, given motion, and given 
perspective, as well as be combined to create split-screen and picture-in-picture 
effects. With 3D transforms, clips can be spun and rolled in three dimensions to 
create stunning effects. 

The possibilities are almost endless, because not only can you transform 
individual clips, you can also transform entire video tracks and even collections 
of video tracks in video groups. 
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Transforms are actually a type of adjustment, available from the Properties pane 
when you select a clip, track, or group.  

Several key techniques use transforms—here's a quick summary with some 
examples. We've used a plain background CG clip for clarity. 

Scaling and 
rotation 

Scaling can be performed to reduce the size of an upper clip 
placed over a lower clip. This is used for picture-in-picture 
effects. 
 

 

Rotating can also be carried out to rotate the upper clip over 
the lower clip.  

 

Motion By using scaling and/or rotation (as above) in combination 
with changing properties over time, you can create motion. 

2D 
Perspective 

2D Perspective lets you create a sense of depth in your movie. 
The transform region can be manipulated into different 
shapes that simulate three dimensions.  
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Split Screen Split screen effects let you create double (below), triple, or 
quadruple video layouts on one screen. 

 

3D 
Transforms 

Spinning, rolling and scrolling effects can be achieved in three 
dimensions. 
 

 

Video overlays 
You can "layer" all sorts of different kinds of clips on top of existing video or 
image clips—this flexibility opens up a world of possibilities in your video 
production. 

Overlays, in basic terms, are two or more clips being displayed at once, one on 
top of the other—these clips are layered on multiple video tracks. For the bottom 
clip to still be visible despite having another clip on top of it, the top clips need 
to: 

• Be smaller than the bottom clip. 

• Have transparent regions. 

• Have reduced opacity. 
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Top clip made smaller 

When you add an opaque clip to the upper track, it is likely to occlude clips on 
lower tracks completely, so all you can see is the content of the top-most track. 
To see "around it" to underlying clips you can resize your top clip by using a 
Transform adjustment on the upper clip or track. You can also reshape your 
clip, deform with perspective and even animate the resizing or reshaping 
process. See Introducing 2D and 3D transforms on p. 105 to learn more. 

 

 

Timeline 

 

 

Video preview—before transform Video preview—after transform (and 
crop) 



Editing in Timeline mode 109

 

Top clip has transparent regions 

Overlaid video 

In the example above, the top clip was completely opaque and therefore 
obscured all video underneath it. However, when you add a video with 
transparent regions to the upper track, the content of underlying tracks will be 
seen through the upper clip's transparent regions. We've added a sample from 
the Library tab on the Media pane to make the above example more compelling. 

 

 

 

Timeline Video preview 

Overlaid STV video 

You can make your own overlay animations and effects using Serif DrawPlus, if 
you export your keyframe animations as Serif Transparent Video (STV). 
Remember to choose the STV format to export with a transparent background! 

When you add an STV video file to a track above existing video or images, 
MoviePlus will smoothly overlay the STV on top, revealing underlying clips 
through the video's transparent region(s). 
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Overlaid images 

If the image on the top track has built-in transparency you will automatically be 
able to see through the transparent region to any underlying clips. This principle 
is frequently seen when television broadcasters display a static logo watermark in 
the corner of the screen. We can do the same with our example, adding an image 
with areas of transparency created in Serif DrawPlus and exported as a 32-bit 
PNG file. 

 

 

 

Timeline Video preview 

If you're looking to create an effect where your video is playing inside a picture—
e.g., a billboard displaying your video—this can be achieved in two ways by: 

• Placing your video above a billboard image and shaping the video to 
match the billboard area using a Transform adjustment. 

• Cutting out the billboard region of the image using a photo-editing 
program such as Serif PhotoPlus (exported as a 32-bit PNG to 
maintain transparency) and placing it on top of your video, perhaps 
shaping your underlying video to match the billboard region using a 
transform adjustment. 
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Both methods have similar results, but the second would allow some foreground 
objects in the image, such as a street sign, to sit in front of the billboard (see 
below). 

 

  

Overlay image Video preview 

Overlaid text 

Text overlays are generally used for captions but can also include overlaid titles 
and credits. By adding a text clip to the upper video track, the text will be 
displayed in front of any underlying video. See Adding text (p. 147). 

Returning to our previous example, a caption could be added to describe the 
footage which is playing. 

 

 

 

Timeline Video preview 
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Top clip with reduced opacity 

There are a number of ways to reduce the opacity of upper clips to partially 
reveal underlying clips. Select a clip on the timeline and then adjust the Opacity 
on the General tab on the Properties pane. 

 

 

 

Timeline Video preview—opacity set to 50% 
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Applying video effects 
Effects can add variety and visual excitement to a video. Some effects, like 
Brightness/Contrast or Gamma, are designed to correct the original video; 
others, like Filter Effects, Mosaic or Diffuse Glow, are simply special effects. 

The supported special effects are described as follows (see also effects for colour 
correction on p. 123): 

• Chroma Key - A method of removing a colour (or a colour range) 
from one video to reveal another video or image behind it. The 
"removed" colour becomes transparent. 

• Colourize - Offers an easy way to apply a colour tint/wash. 

• Diffuse Glow - This broadens highlights in the video by brightening 
gradually outward from existing highlights. 

• Emboss - The Emboss effect remaps contours to simulate a bas-relief 
effect. This creates a convex rounded edge and shadow effect. 

• Filter Effects - Filter Effects encompass Shadows, Glows, Bevels, 
Emboss, Colour fills and 3D special effects. Apply individually or in 
combination. 

• Gaussian Blur - The Gaussian Blur effect smoothes the image or video 
by averaging pixels. It's especially useful for removing a moiré 
(interference) pattern from scanned images and can help clean up 
regions of visual interference from fine patterns. 

• Gradient Map - The Gradient Map adjustment is for remapping 
lightness information in the video to a new colour range. It makes for 
great "posterized" effects and is a quick substitute where a pop-art feel 
is being sought. 

• Greyscale - This effect creates shades of grey; monotones ranging 
from black through to white. 

• Invert - This effect inverts the colours, in the same way that a photo 
and its negative are opposites of each other. 
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• Mask - The Mask effect is a useful way to convert a clip into a more 
suitable mask by adjusting its lightness or other tonal values. 

• Mosaic - The Mosaic effect creates blocks of uniform colour for a tiled 
appearance. 

• Motion Blur - Exaggerate motion in your video, by blurring object 
movement. 

• Noise - The Noise effect adds graininess. 

• Old Film - Use the effect to simulate vintage film; control ageing and 
film quality. 

• Solarize - The solarize effect is similar to a Negative Image function, but 
lets you set the threshold value above which colours can be inverted. 
(Solarization is a darkroom technique in which a partially developed image 
is re-exposed to light, producing dramatic changes in mid-tone regions). 

• Threshold - The Threshold effect creates a harsh duo-tone black and 
white image, with no blend through shades of grey. 

• Unsharp Mask - Unlike many sharpening tools that affect the entire 
video, the Unsharp Mask effect works mainly at edges. It's excellent for 
improving clip quality. 

 Audio special effects (see p. 124) can also be applied to audio clips. 
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Effects can be added, modified, and deleted from the Properties pane. 

 

• Applied effects are shown under the 
Effects category; effects appearing at 
the top of the list are applied to the 
clip, track, or group first. 

• When selected from the list, the 
effects' parameters can be adjusted 
directly in the pane. 

• Any modified effect can be saved for 
future use. 

Adding video effects 

To add an effect: 

1. Select the clip on the storyboard (or clip, track, or group on the 
timeline). 

2. From the Properties pane, click Add Effect....  

3. From the flyout, choose a category (see explanations above). 
 

 

4. In the pane, edit the parameters. 
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The effect is added to the Properties pane's Effects category; an  Applied 
Property indicator next to the effect name indicates the effect has been applied. 

 If you've made your effects change over time (p. 86), the above 
indicator will possess a red centre to indicate that keyframes are 
being used. 

To add an effect preset: 

1. From the Galleries pane (Video Effects gallery), select an effect tab.  

2. Drag and drop your chosen effect onto the clip, track or group. 
OR 

1. From the context toolbar, select  Add Effect. 

2. From the Choose Effect dialog, navigate the tree menu structure and 
choose a preset effect. 
 

 

3. Click OK. The effect is added to the Properties pane's Effects category. 

 In Storyboard mode, a clip with an effect applied will show the 
 symbol under its thumbnail. Click the symbol to view applied 
effects. 
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Any effect added to your project will have its own set of parameters associated 
with it. The effect's parameters can be altered in the Properties pane. 

To modify an effect: 

1. Select the clip, track or group. 

2. From the Properties pane (Effects category), choose the effect to be 
edited from the effects list. 

3. Alter the effect's parameters. 

To change effect order: 

• From the Properties pane, drag the effect up or down in the effects list. 
A move cursor will appear as you drag the effect. 

To copy a video effect: 

• Drag and drop the effect's name from the Properties pane onto a 
"target" clip, track, or group. 
OR 

• Click  Copy in the effect's Properties pane. To apply, right-click a 
"target" clip, track, or group and select Paste. 

To save a modified effect to a new name: 

• Click  Add to Gallery. Once named, the effect appears as a new 
preset in the appropriate folder in the Choose Effect dialog (or 
Galleries pane; Video Effects gallery). 

Video effects on the timeline 

The same principles as those described in Arranging tracks can be used when 
adding and combining video effects on the timeline, i.e. effects can be organized 
in the timeline's header region in a vertical sequence, composed from the top 
downwards just like video and audio tracks. 
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Changing properties over time 

A powerful feature of MoviePlus's Timeline mode is the ability to change 
properties (of adjustments, effects, or transitions) over the clip's playback 
duration. This is done by using keyframes, placed under the clip on the timeline. 
Each keyframe possesses its own properties, which affect the clip from that 
keyframe position onwards. Tracks and groups can be affected similarly. For 
more details, see Changing properties over time (p. 86). 

2D filter effects 
MoviePlus provides a variety of filter effects that you can apply to any clip with 
transparent regions (e.g., an overlay or CG QuickShape clips). The effect works 
on the edges of the visible portion of your image to offer shadows (below), 
glows, bevels, and emboss effects. 

 

"3D" filter effects (see p. 122) let you create the impression of a textured surface 
and are covered elsewhere. 

To apply 2D filter effects: 

For a preset effect: 

1. Select the Filter Effects tab on the Video Effects gallery (Galleries pane). 

2. Drag and drop a Filter Effects thumbnail onto your clip. 

For a customized effect: 

1. Select your clip, then from the Properties pane (Effects tab), click Add 
Effect.... 

2. Select Filter Effects and then, on the Properties pane (Filter Effects), 
click Edit Effects.... 

3. In the Filter Effects dialog, click an effect and update its properties. 

4. Click OK. 
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To edit a filter effect: 

1. From the Properties pane (Effects tab), select "Filter Effects" in the effects list 
and click the Edit Effects... button. The Filter Effects dialog is displayed. 

2. (Optional) If needed, expand the preview pane by clicking the 
  Show/Hide Preview button. When expanded, the effects are 
applied only in the preview window. While the pane is collapsed (click 
the button again), filter effects are applied directly to the clip. 

3. To adjust the properties of the effect, select its name and vary the 
dialog controls. Adjust the sliders or enter specific values to vary the 
combined effect. (You can also select a slider and use the keyboard 
arrows.) Options differ from one effect to another. 

4. Click OK to apply the effect or Cancel to abandon changes. 

Creating outlines 

MoviePlus lets you create a coloured outline around objects, especially text and 
shapes (as a filter effect). For any outline, you can set the outline width, colour 
fill, transparency, and blend mode. The outline can also take a gradient fill, a 
unique contour fill (fill runs from the inner to outer edge of the outline width), 
or pattern fill and can also sit inside, outside, or be centred on the object edge. 

As with all effects you can switch the outline effect on and off. You'll be able to 
apply a combination of 2D or 3D filter effects along with your outline, by 
checking other options in the Filter Effects dialog. 

Blur 

Various blur effects can be applied to MoviePlus objects. The types of blur 
include: 

• Gaussian: the effect smoothes by averaging pixels using a weighted 
curve. 

• Zoom: applies converging streaks to the image to simulate a zoom 
lens. 

• Radial: applies concentric streaks to the object to simulate a rotating 
camera or subject. 
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• Motion: applies straight streaks to the object to simulate the effect of 
camera or subject movement. 

3D filter effects 
3D filter effects create the impression of a textured surface on any clip. You can 
apply one or more effects to the same clip—3D Bump Map, 3D Pattern Map, 
and 3D Lighting are all available. Some impressive effects can be achieved on a 
whole range of objects, particularly Text, Background and QuickShape clips. 

   

To apply 3D filter effects: 

For a preset effect: 

1. Select the Filter Effects tab on the Video Effects gallery (Galleries 
pane). 

2. Drag and drop a Filter Effects thumbnail onto your clip. 

For a customized effect: 

1. Select your clip, then from the Properties pane (Effects tab), click Add 
Effect.... 

2. Select Filter Effects and then, on the Properties pane (Filter Effects), 
click Edit Effects.... 

3. In the Filter Effects dialog, click an effect and update its properties 
using the controls on the right. 

4. Click OK. 

For more details about 3D Filter Effects, see MoviePlus Help. 



Effects 123

 

Colour correction 
MoviePlus offers a wide variety of colour adjustment presets that you can apply 
to clips. These adjustments—to brightness, contrast, hue, and so on—are 
normally carried out on clips, as most deficiencies will be inherited from the 
recording of the clip (e.g., over-exposure, poor weather conditions, etc.). 

Colour correction effects are applied and managed in the same way as for any 
other effect, i.e. via Add Effect... on the Properties pane. See Applying video 
effects on p. 113 for more information. 

Let's take a look at the colour adjustments in turn. 

Adjust HSL Hue, Saturation, and Lightness (HSL) are components of a 
standard colour model that's used to identify colours. 
Generally speaking, Hue refers to the colour's tint—what 
most of us think of as rainbow or spectrum colours with 
name associations, like "blue" or "magenta." Saturation 
describes the colour's purity—a totally unsaturated video 
has only greys. Lightness is what we intuitively understand 
as relative darkness or lightness—ranging from full black at 
one end to full white at the other. Adjust HSL lets you alter 
these components independently. 

Brightness / 
Contrast 

Brightness refers to overall lightness or darkness, while 
contrast describes the tonal range, or spread between 
lightest and darkest values. This is a "quick and dirty" way 
of correcting a clip, for example one that was over-exposed 
or under-exposed. 

Channel 
Mixer 

The Channel Mixer adjustment lets you adjust each 
separate colour channel (Red, Green, or Blue) using a mix 
of all the current colour channels. 

Colour 
Balance 

The Colour Balance adjustment lets you adjust colour 
balance for general colour correction in the 
clip. Combinations of Cyan/Red, Magenta/Green and 
Yellow/Blue can be adjusted to lower or raise each colour 
mix. 
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Curves The Curves adjustment lets you correct the tonal range of a 
clip—the spread of lightness values through shadow, 
midtone, and highlight regions—and control individual 
colour components. 

Gamma The Gamma adjustment lets you adjust the amount of mid-
tone brightness in your clip. Think of midtones as the grey 
shading that lie between shadows and highlights present 
throughout your clip. 

Levels The Levels adjustment lets you emphasize mid-tone 
lightness regions in each or all of the three primary video 
colours, red, green, and blue. 

Applying audio effects 
In the same way that you can apply video effects to video clips, you can apply 
audio effects to audio clips also. In fact the process of applying and editing 
effects is identical for both—MoviePlus treats them equally. 

Audio effects range from more commonly encountered effects such as Bass and 
Reverb, to more technical effects such as Low Pass, High Pass, Compressor, 
Expander, and many more. 

Whichever effect you want to apply you'll need to have recorded, captured, or 
imported your audio file in advance; the file must also be present as a clip on 
your storyboard or timeline. Once present, the clip can have an effect applied. 

Effects can be added, modified, and deleted from the Properties pane. 

 

• Applied effects are shown under the 
Effects category; effects appearing at 
the top of the list are applied to the 
clip, track, or group first. 

• When selected from the list, the 
effects' properties can be adjusted 
directly in the pane. 

• Any modified effect can be saved for 
future use. 
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 In Timeline mode, an audio effect can be equally applied to an 
audio track or bus, as well as an audio clip. This will influence the 
audio of a clip on the same track or bus. 

Adding audio effects 

To add an effect: 

1. Select the audio clip on the storyboard (or clip, track, or bus on the 
timeline). 

2. From the Properties pane, click Add Effect....  

3. From the flyout, choose a category. 
 

 

4. In the pane, edit the parameters.  

The effect is added to the Properties pane's Effects category; an  Applied 
Property indicator next to the effect name indicates the effect has been applied. 

  If you've made your effects change over time (p. 86), the above 
indicator will possess a red centre to indicate that keyframes are 
being used. 



126 Effects 

 

To add an effect preset: 

1. From the Galleries pane (Audio Effects gallery), select an effect tab.  

2. Drag and drop your chosen effect onto the clip, track or group. 
OR 

1. From the context toolbar, select  Add Effect. 

2. From the Choose Effect dialog, navigate the tree menu structure and 
choose a preset effect. 

3. Click OK. The effect is added to the Properties pane's Effects category. 

Any effect added to your project will have its own set of parameters associated 
with it. The effect's parameters can be altered in the Properties pane. 

To modify an audio effect:  

1. Select the audio clip, track or bus which has the effect applied. 

2. From the Properties pane (Effects category), choose the effect to be 
edited from the effects list. 

3. Alter the effects' parameters at the bottom of the tab. 

To copy an audio effect: 

• Drag and drop the effect's name from the Properties pane onto a 
"target" clip, track, or group. 
OR 

• Click  Copy in the effect's Properties pane. To apply, right-click a 
"target" clip, track, or group and select Paste. 

To save a modified effect to a new name: 

• Click  Add to Gallery. Once named, the effect appears as a new 
preset in the appropriate folder in the Choose Effect dialog (or 
Galleries pane; Audio Effects gallery). 
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Using third-party effects 

While MoviePlus is packed with a range of preset audio effects you can also 
adopt third-party plug-in VST effects (up to V2.4). If you've already 
downloaded such effects independently of MoviePlus you can make them 
available from either the Properties pane or Galleries pane (Audio Effects) by 
copying them to the MoviePlus install sub-folder called "VST". You'll need to do 
this before running MoviePlus. By default, this folder will be C:\Program 
Files\Serif\MoviePlus\X6\VST\. 

The installed VST effects can be applied in exactly the same way as MoviePlus's 
audio effects—you can adjust their properties in the Properties pane. Note that 
some more advanced VST effects can be modified with a VST Properties button 
(in the same pane). 

You can optionally store your VST effect plug-ins in a folder of your choice, but 
you'll have to point to this folder via Tools>Options (Folders menu option) for 
the effects to show in the panes. 

 Installed VST effects are also shown in the Audio Effects pane in 
folders named with a [VST] suffix. 

Changing properties over time 

A powerful feature of MoviePlus's Timeline mode is the ability to change audio 
effects over the clip's playback duration. This is done by using keyframes, placed 
under the clip on the timeline. Each keyframe possesses its own properties, 
which affect the clip from that keyframe position onwards. Tracks and groups 
can be affected similarly. For more details, see Changing properties over 
time (p. 86). 
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Introducing audio 
In MoviePlus, it's possible to use audio clips which have been collected by a 
variety of methods. 

 

• Capturing audio: The capture process is capable of capturing just the 
audio element from a tape-based camcorder's combined video/audio 
input or audio from a microphone (see Capturing video in MoviePlus 
Help). 

• Importing: You can make use of audio files already on your computer 
by simply importing them into your project. 

• Recording Narration: Narrate commentary via microphone as you 
playback your movie. Narration can play back over existing audio 
(e.g., on a Music soundtrack). 

• CD Ripping: Digital ripping of music CDs means that you can adopt 
your favourite songs as supporting soundtracks in your movie. 

Whichever method you choose, audio files will be added to your Media pane. 
Narration files are also added to the storyboard or timeline automatically (at the 
time indicator position at which you started recording). 
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 The capture or copying of a video file from your respective tape- or 
file-based camcorder to your project will include accompanying 
audio along with your video clip automatically. 

Audio editing 

Audio can play an essential part in any movie, and creative audio editing is an 
art in itself. Standard ingredients of audio might include: 

• Production sound as originally recorded (and later captured) “in sync” 
along with the video, e.g. camcorder footage of your last holiday. 

• Narration (or voice-over passages) serving as a commentary or a 
bridge between sections of your movie. 

• Theme music or background sound from a variety of clips, often 
added as one or more longer clips that run “under” audio narration. 

• Sound effects or single-shot audio events, perhaps added for emphasis 
(“sweetening”) or comic relief. 

If you would like your movie to include more than basic production sound, 
allow yourself some time to do it right! Skilful sound editing is a combination of 
technique and judgement. Fortunately, MoviePlus makes the technical part 
straightforward. Getting sound to coincide properly with the visual track, to 
come in on cue and end (or fade out) at just the right moment, to blend well 
with other audio... all are easily accomplished in the Timeline mode. 

Adding audio 

 

Audio files can be added to your Media pane in various ways 
(see Introducing audio on p. 129) and will always show with 
an audio icon as a thumbnail. If capturing, the default prefix 
is "Capture". 

Once in your project you'll want to add one or more audio files to either your 
storyboard or timeline. One exception is when you're recording narration as the 
narration clip will be added automatically to storyboard or timeline. 
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 Use  Trim on the Media pane to trim your audio file in the 
same way as a video file. 

Adding audio to the storyboard 

 

If the storyboard is empty, drag your audio clips so that they 
snap onto either the horizontal Narration or Music strips at 
the bottom of the storyboard. 

You'll see a orange strip (indicating selection) appear under 
the thumbnails which indicates the audio clip. Click away 
from the clip to deselect it (it turns blue; below). The audio 
clip snaps to the start of any clip. 

 

The clip is selectable and as such has its own properties (i.e., Gain and Pan) 
which can be adjusted (via the Properties pane). See Volume and pan on p. 139. 

Adding audio to the timeline 

Whenever you add a video clip with an audio component to the timeline, the 
audio portion (if present) is automatically added to an available audio track 
underneath the video track. These two clips maintain a linkage by default, as 
shown when you select either clip—an orange border indicates the current 
selection, while a blue border indicates the linked accompanying clip. 

 

However, when you add a standalone audio file (e.g., wav or mp3) it can be 
dragged onto the available Music track (or you can create your own audio track). 
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Audio tracks are managed in much the same way as video tracks, and by the 
same token, audio clips are managed as for video clips. Please see Adding and 
arranging tracks and Arranging clips on p. 64 and p. 70, respectively, for more 
information. 

In terms of playback, the audio clip is treated as for a video clip—seek controls 
can be used, along with trick play and scrubbing. 

Audio waveform displays (Timeline mode only) 

  

mono stereo 

Note that the waveform display does not reflect the audio volume, as volume and 
dynamic range represent two different elements of audio. If you increase the 
volume the dynamic range does not change (and vice versa). 

Waveforms are not generated automatically when your audio is added to the 
timeline. Instead you generate audio waveforms as you require them on the 
audio track. 

To generate waveforms for audio clips: 

• On the audio track's header, click the  Minimize/Restore button. 
 

 

The audio waveforms for all clips on the track are generated. 

The waveform displays can be hidden again by clicking the Minimize/Restore 
button in the track header. 

To switch off waveform generation: 

• In Tools>Options>General, uncheck Generate audio waveforms 
automatically. When you restore an audio track, waveforms are no 
longer generated. 
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 If you've already generated waveforms for clips they will still display. 
As waveforms are actually stored in waveform files (per clip) you'll 
need to delete these waveform files in Helper File Manager on the 
File menu. 

Even though you may have switched off waveform generation, you can still 
generate waveforms per clip. 

To generate a waveform per clip: 

• Right-click an audio clip and select Generate Waveforms. 

 You can generate waveforms before adding clips to the timeline by 
right-clicking your clip in the Media pane and selecting Generate 
Waveforms. This avoids having to process all waveforms 
simultaneously when adding to the timeline/storyboard. 

Interpreting waveforms 

The following example waveform shows a typical stereo waveform display. You 
can interpret your waveform by analysing peaks in the dynamic range indicative 
of passages of conversation and audio events (shouting, gunshots, bangs on the 
microphone, etc.). 

By being alerted to these, you can perform audio trimming and splitting more 
effectively. 
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Audio fading (Timeline mode only) 

In a similar way to video in/out transitions, any audio clip can have an audio 
transition. By default, when overlapping audio clips have been placed on the 
timeline (normally as a result of adding multiple video clips with accompanying 
audio clips) an automatic transition of type "Fade" is produced between 
overlapping audio clips. The transition smoothly blends the first clip's audio 
with the second clip's audio while maintaining the same audio levels throughout 
the transition's duration. 

For non-overlapping audio clips, perhaps at the start or end of the timeline, a 
manual transition can be applied—this fades-in or fades-out an audio clip at the 
start or end of that clip, respectively. To apply, simply drag the blue triangular 
handle to the left (shown below) or right to produce the Fade transition. The 
length of the transition dictates the duration of the fade-in/out. 

 

The duration of any manual Fade transition can be changed by dragging its 
handles or changing the Duration value in the transition's Properties pane. An 
automatic transition's duration can also be changed in the transition's Properties 
pane or by moving either clip in relation to the other (the automatic overlap 
defines the duration). 

For automatic or manual transitions, you can adjust the Interpolation in the 
same pane—this alters the rate of change for the progression of the whole 
transition. The default is Linear, but other settings offer slow and/or fast 
beginnings and/or ends to the change. 

Audio muting 

Audio clips can be muted by clicking the Mute  on the clip's Properties 
pane (General tab). The audio clip, either standalone or linked to a video clip, 
will turn black to indicate its mute status. 
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Using audio buses 
Audio buses are commonly encountered in professional music production for 
the control and management of audio tracks. By sending different audio tracks 
to different buses, the sound engineer has full control over how to "shape" the 
sound to his liking. In MoviePlus, the same logic can be applied to audio tracks 
in your project. 

It is possible to use an audio bus to adjust overall gain (volume) and/or pan in your 
project. All audio tracks are directed by default to a single Master Bus, which can 
be modified to influence its associated audio tracks. Additional buses can also be 
created, allowing audio tracks to be directed to different custom buses. 

 

In the example above, independent Pan/Gain control of audio tracks is shown, 
with overall Pan/Gain control via the Master bus. The created custom Bus 1 can 
be used to apply an effect (e.g., Reverb) to audio tracks 2, 3, and 4. 
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Gain and pan adjustments, plus audio effects, can be applied to any bus. 

Displaying buses 

•  Select Show Audio Buses from the View menu. 

The Master Bus is displayed at the bottom of your timeline, along with any 
previously created custom audio buses. 

 

Creating audio buses 

• Select Audio Bus from the Insert menu. 

The new bus is added under the Master Bus at the bottom of your timeline, and 
is named Bus 1 or Bus 2, etc. 

 

Modifying a bus 

1. Select the bus on the timeline, by clicking its name. 

2. From the Properties pane, alter properties (name, Gain, and/or Pan). 

By default, all audio tracks are directed to the Master Bus. If you've created a 
custom bus, you'll need to direct the appropriate audio tracks to that new bus. 

Assigning audio tracks to custom buses 

1. Select an audio track. 

2. From the Properties pane (General tab), select the chosen bus from the 
Target Bus drop-down list. 
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Volume and pan 

Checking audio levels 

 

The Levels meter can be used to study project-wide volume and pan 
settings, and to help you to attain optimum volume and pan—this is 
just as essential to a well-designed movie project as hours devoted to 
video editing. 

 The meter is hidden by default but can be switched on 
by selecting Show Levels Meter on the Preview menu. 
The meter is displayed on the Video Preview pane. 

Two meters display the entire project's audio levels. The left and 
right meters represent the left and right stereo channels, respectively, 
and report the audio levels in decibels (dB). 

The meter levels will increase and decrease according to the volume 
level at that point in the project's playback. 

The concept of the Levels meter is straightforward—the levels will 
peak and dip according to currently played audio levels. You may 
have experienced this on music systems while recording. 
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At some point, the meters may indicate that excessive volume levels are being 
experienced, i.e. the levels go above 0 on any meter. This is known as digital 
clipping  (also known as square wave clipping). It is vital that such clipping does 
not occur in your project, so you have to set the loudest part of your audio clip 
to peak below 0 dB (or face audio distortion). 

How do you know when clipping occurs? At the top of the example meters 
opposite, you'll notice two numbers at the top of each meter. The values represent 
the maximum level or "high-watermark" for each channel if clipping occurs during 
the current playback. Again using the example, the left and right channel have at 
some point during playback peaked at +7.1 dB. You can leave your project to play, 
then return to check for clipping—if no values appear in red then no clipping has 
occurred. This saves you from having to watch the entire project's playback! 

 These values are always reset when playback is restarted. 

Assuming you've managed to prevent any clipping from occurring, you have to 
then consider how the audio sounds when played on a target device (e.g. via the 
web or on a created disc). You should aim to peak your audio levels at 
approximately -20dB (used for professional digital audio). 

The meter only gives an accurate indication of incorrectly set audio clips or 
tracks—whether high or low. The prime objective is therefore to resolve 
unacceptable volume levels which we'll look at next. 

Adjusting volume 

Volume adjustment of clips 

The volume adjustment on any selected audio clip (or even video clip with audio 
stream) can be made by altering Gain in the object's Properties pane (select 
Adjustments>Volume). For example, the Gain can be reduced by dragging the 
slider to the left (from its default 0.0 dB position). 
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Adjusting pan 

Adjusting the pan follows the same principles as adjusting volume. The 
adjustment can be made by altering Pan in the object's Properties pane (select 
Adjustments>Pan). For example, the pan can be reduced by dragging the slider 
to the left (from its default "Centre" position). 

 

Changing properties over time 

A powerful feature of MoviePlus's Timeline mode is the ability to change volume 
and pan over the clip's playback duration. This is done by using keyframes, 
placed under the clip on the timeline. Each keyframe possesses its own 
properties, which affect the clip from that keyframe position onwards. Tracks 
and groups can be affected similarly. For more details, see Changing properties 
over time (p. 86). 

Adding narration 
Narration means a passage of speech, normally an accompanying story (or a set 
of instructions), used to support the visual imagery of a movie. 

In MoviePlus, narration is possible in either Storyboard or Timeline mode, by 
choosing the point from which to start recording your narration clip (set your 
time indicator first). As you play back your movie, you record your narration in 
real-time, then stop recording. The clip is automatically added to the storyboard 
or timeline, and is also added to the Media pane. 

On the storyboard, the narration clip (Narration004) appears on the Narration 
strip under your thumbnails after you've stopped recording. See Storyboard 
basics on p. 47. 

 

On the timeline, the narration clip is added from the set time indicator on a 
Narration track; the track is added automatically to your timeline, and can be 
manipulated as for any audio track. 
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See Volume and pan on p. 139. 

For timeline narration, you can expand the Narration track to automatically 
generate audio clip waveforms (below), a visual representation of audio activity 
in the clip. In doing so, you can trim and split the audio clip to just passages of 
narration, making it easier to match narration to your video footage. 

 

Setting up your microphone 

Two microphone setups are likely: either a separate microphone and stereo 
headphones, or an integrated microphone in headphones. Devices may connect 
either via USB or via your computer's sound card (sometimes indirectly from 
your computer's front panel). Connected devices should be plug-and-play so 
don't need to be set up manually. 

 

 

Most headphones are generally equipped with 3.5 mm jack plugs. 
Check the symbols on the jack plug then match these up with the 
same symbols on your computer's input sockets. 

Consult your microphone documentation and Microsoft Windows for details on 
how to set up your audio device on your computer. 

For laptop users, your microphone will be built in, so you won't have any 
connectivity issues. 

Recording 

The Record Narration dialog lets you alter your recording setup (e.g., 
microphone clip) and start (and stop) the recording. During recording, a Levels 
meter indicates the current audio level. 

For audio recording advice, see the Shooting Guide chapter of the MoviePlus X6 
Director's Guide (purchasable). 
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To record a narration: 

1. Move the time indicator in the Video Preview pane to a chosen 
recording start point (or select a clip on the storyboard to record from 
the beginning of that clip). 

2. Click  Record Narration on the Storyboard or Timeline toolbar.  

3. From the Record Narration dialog, optionally choose a different 
Source (e.g., "Microphone") if you have multiple audio input devices, 
an Input, or a different audio Format. 

4. Speak into your microphone to check levels. If the volume is excessive, 
the Levels meter will show clipping (red areas showing at the top of 
each meter). To rectify, lower the  Master Volume slider until 
clipping no longer occurs. 

5. Uncheck Mute audio when recording if you want existing audio to be 
played through your computer speakers (and picked up via microphone) 
as you record. Normally, you'll want to keep this checked to mute your 
audio as you record (or use headphones), to avoid "echoing". 

 Another source of echoing is when the Windows Volume Control 
outputs the microphone audio through the speakers, so it gets 
picked up by the microphone again (feedback). Avoid echoing in 
this case by use of headphones or by muting the microphone 
output. 

6. To start recording, click the Record button and begin your narration. 
Click Stop button when you've finished speaking. If the end of the 
project is reached the recording will stop automatically. Your 
narration shows on your storyboard or timeline when you stop 
recording. 

 Click the Windows Mixer... button if you need to adjust MoviePlus 
volume levels from Windows. 
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Ripping audio CDs 
There may be occasion when you may want to adopt some of your favourite 
audio for use in your MoviePlus project, whether as a complete song, piece, 
narration, or as a smaller excerpt. If located on an audio CD, MoviePlus can use 
ripping to capture each audio track sequentially; each track shows in your Media 
pane after audio ripping. By default, tracks are saved as compressed wma files. 

 

The dialog shows in-progress track-by-track digital ripping from an audio CD. 
Track 1 is being ripped from the audio CD in drive F (and saved in 
c:\musicroom\). 

To rip an audio CD: 

1. Click  Import Media on the Tasks toolbar (or from the top of the 
Media pane). 

2. From the drop-down list, select Rip CD. 

3. From the dialog, choose a Device from the drop-down list; this is the 
disc drive currently containing your audio CD. 
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4. (Optional) Use the playback controls under the track list to review 
tracks on your CD, e.g. use the  button to play a selected track. 
A bar under the play control buttons indicates the audio playback 
progress. For ripping selected track only, uncheck unwanted tracks 
from the list. Otherwise, all tracks are ripped. 

5. Use the Browse... button to specify a location that the audio files will 
be ripped to. 

6. (Optional) Instead of a file name Prefix of "Capture" enter your own 
prefix. MoviePlus will name each captured file with an incremented 
number suffix. 

7. (Optional) Enable the "WAV (uncompressed)" option, if you want 
uncompressed larger files. For wav rips, a typical 4 minute audio track 
will occupy about 40MB of hard drive space (typically 700MB per 
audio CD). Otherwise, keep the "WMA" option enabled to create 
smaller file sizes. 

8. Click the Rip CD button to start ripping your checked audio tracks. A 
currently ripped track will show a  symbol next to it; a green 
progress bar indicates that ripping of that track is in progress. 

You'll notice that ripped audio files will appear in your Media pane (in the root 
of your Project tab). 

When you've finished capturing your audio, click the Close button to return to 
MoviePlus. 
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Adding text 
MoviePlus provides a high level of support for managing text in your project. 
Typically, text within MoviePlus can be used for titles, captions, or credits. 

 

Titles 
No movie is complete without initial 
titling to introduce the movie's name 
to the viewer. 

 To add impact, Titles can 
be animated! 

 

Captions 
Captions are always overlaid over an 
existing video or image clip, and 
display for that clip's duration. They 
are used to explain and provide 
context to the clip currently being 
displayed. 

 

Credits 
Credits tend to appear at the end of 
your project, where you may want to 
acknowledge actors, contributors 
and copyright information. 

However you plan to use your text, you create text as a text clip. This clip 
behaves much like a video clip but is purely a container for your text. You can 
position your clip on the same video track as your video clip, or above a video 
track for use as captions. By default, MoviePlus offers an Overlay Track on your 
timeline which is ideal for storing text clips as captions. 
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The text within your text clip is called a text object. A text object is a single 
instance of text which can be easily edited, when selected, using the following 
tabs on the text object's Properties pane. 

• General: Control scrolling, background fill, playback and opacity. 

• Format: Apply a different font, font attributes, and effects. Ready-to-
go text style presets can be selected instead. 

• In Animation/Out Animation: Make your titles and credits come to 
life—apply Blinds, Fly, Slide, Spin, and more. 

You can add additional text objects to your text clip at any time. Text clips can 
also have supporting images and QuickShapes added to them. (See Adding 
images and QuickShapes on p. 161.) 

Titles 

Titles are typically presented at the very beginning of your project. They tend to 
be a single word or at best only a few words long, but are usually shown in a 
large font size. 

To add a title: 

1. On the storyboard, select a clip (usually the first) before which the title 
will be added. 
OR 
On the timeline, set your time indicator's position (no clip selection 
needed). 

2. From the context toolbar, select  Insert Text, then Text Clip from 
the drop-down menu.  

3. In the Video Preview pane, select the text and then type directly into 
the text box to add your own title text. 
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4. From the Properties pane (Format tab) choose your font type, font 
size, text alignment, font colour, transparency, line style and whether 
text is to be bold, italic and/or underlined. See Formatting text on 
p. 156. 
OR 
Select a text style preset from the thumbnails. 

 Apply a coloured solid or gradient Background Fill for the text clip 
via the Properties pane (General tab). 

 Alternatively, display the Galleries pane, select the  Text gallery 
and Titles tab, then drag and drop your chosen preset onto your 
storyboard or timeline. 

Captions 

Captions are typically superimposed onto an existing clip to explain the 
underlying clip in text form. For example, you could describe a clip's location, 
subjects in shot, etc. 

To add a caption: 

1. Select a video or image clip (or in Timeline mode, position your time 
indicator over the clip). 

2. From the context toolbar, select  Insert Text, then Caption from 
the drop-down menu.  
 
In the Video Preview pane, you'll see caption text added in front of the 
clip, using the name of the video or image clip as its text. 

3. Type directly into the text box to enter your own caption text. 

In Timeline mode, the caption text clip is added directly above the selected clip; 
both clips will be of equal duration. The Overlay Track, shown above all other 
tracks is intended to store your caption text clips. 
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 The  button on the Video Preview pane can also be used to add 
text, and is available when the Time indicator (caret) is over a clip. If 
over a video clip, you'll get a caption; if over a text clip, an additional 
text object is added to that text clip; if over an existing caption you 
get More Text. 

 You can change a caption's start time and/or duration from the text 
clip's Properties pane (General tab). 

 To apply caption text to multiple video clips, select the clips first 
using Shift-click before adding your caption. 

  In Storyboard mode, a clip with a supporting caption will show 
the icon under its thumbnail. 

Credits 

Credits are used to acknowledge cast and crew, as well as copyrights. They 
usually close a movie and tend to be presented on a neutral background 
(typically black). As a result, in MoviePlus it's best to present credits on their 
own text clip rather than as an overlay. This stops the viewer from being 
distracted by the underlying video clip. 

A possible requirement when adding credits is the ability to display more than 
one frames worth of text (you may have a long list of cast, crew, and copyright 
information to acknowledge!). This is made possible by using rolling credits—
the credits are made to move up, down, left, or right. 

To add credits: 

1. Deselect all clips and move the time indicator to the end of the last clip 
in your movie. 

2. From the context toolbar, select  Insert Text, then Text Clip from 
the drop-down menu.  

3. Type directly into the text box selected in the Video Preview pane and 
edit as described on p. 156. 
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4. (Optional) To scroll overflowing credit text, set Scrolling in the 
Properties pane (General tab)—choose from Up, Down, Left, or Right. 

5. Set the Duration of the text clip to a value which allows credits to be 
read comfortably (the greater the duration the slower the credits). 

 Alternatively, display the Galleries pane, select the  Text gallery 
and Credits tab, then drag and drop your chosen preset onto your 
storyboard or timeline. 

 To import text from other Word processing packages, cut and paste 
directly into selected text in your Video Preview pane. For 
paragraphs, you'll need to add your own line breaks to set line 
lengths before copying. 

Adding more text 

It's easy to add a single passage of text by clicking and typing. However, 
MoviePlus can include more text, in addition to the initial text associated with 
the text clip. More text lets you build up additional subtitles, captions, or credits. 
Each text object is independent of each other and can therefore adopt its own 
format, properties, animation, or effect properties. The example below shows 
two text objects, each possessing very different styles. 

 

To add more text: 

1. Select an existing text clip or video/image clip with overlaid text. 

2. In Storyboard mode, select a video or image clip. 
OR 
In Timeline mode, position your Time indicator over the text clip. 
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3. Click  Add a New Text Object on the Video Preview pane. An 
additional text box appears which can be edited as before. This creates 
a new text object associated with the original text clip. 

 In Timeline mode, view all associated text objects under the text clip 
by double-clicking on the original selected text clip. 

Text templates 

If you've spent time creating your text clip with the perfect text style, image 
layout, QuickShape layout, and duration you might want to use this appearance 
in other text clips you subsequently create. This is done by making your chosen 
text clip the default text template. 

To create a default text template: 

•  Right-click the text clip, and select Set as Default Text Template. 

The next text clip you create will be based on the text clip you chose to be the 
default template. 

If you want to make an existing text clip adopt the new text template, you can 
apply the new default template to it. 

To create a text clip based on the text template: 

•  Right-click the text clip, and select Apply Default Text Template. 

 To revert back to the "factory" text template default, choose Reset 
Defaults>Text Template from the Tools menu. 
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Selecting and editing text 
Text editing is possible only once text is selected—corner or edge control 
handles on the selected text's bounding box can be used for different operations. 

Selecting text 

 

For any text clip, click on the text you 
want to edit. A bounding box appears 
around the text once selected. 

 

Click again for a insertion point 
where you can add additional text at 
that point. 

 

To select only part of your text, drag 
over part of your text to select. Typing 
will replace the selected character. 

 

Double-click on a word to select it. 

 

Triple-click anywhere in the 
bounding box to select all text. 

 To select text objects, use the  Select button on the Video 
Preview pane. 
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Editing text 

To edit text: 

1. Click on text in the Video Preview pane to select the text object. 

2. Click again and type to replace all text. 
OR 
 
Drag over characters or words then type to replace highlighted text 
only. 

 Use the Edit menu or keyboard shortcuts to access text editing 
operations such as Cut, Copy, and Paste. 

 You can format text from the Properties pane (Format tab). 

To add a line break: 

1. Click for an insertion point at the position where you want the line to 
break. 

2. Press the Return key and continue typing. 

Formatting text 
MoviePlus lets you apply typical text formatting functions such as: 

• Text formatting (font type, font size, attributes, alignment) 

• Colour fill (solid and gradient) and transparency. 

• Line weight and colour. 

• Filter effects, such as drop shadow, glow, emboss, outlines, etc. 
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Instead of designing text styles from 
scratch you can adopt a text style preset 
from the Properties pane's Format tab. If 
needed, you can then customize text 
further by using the settings above the text 
style presets. 

 You can use the same styles for 
titles and labels when designing 
your disc menu in Menu 
Designer (p. 178). 

To format text: 

1. Select a text clip on the timeline (or an added text object in the Video 
Preview pane). 

2. From the Properties pane's Format tab, you can alter (or apply): 

• Font (typeface), font size, text attributes (bold, italic, underline). 

• Paragraph alignment (left/centre/right). 

• Fill (solid or gradient colour). The swatch, when clicked, lets you 
apply a different preset fill (or edit a fill of your own). The swatch 
changes to reflect the text's current colour setting. 

• Transparency (solid or gradient). The swatch, when clicked, lets 
you apply a different Transparency preset (or a edit a 
transparency of your own). The swatch changes to reflect the 
clip's current transparency setting. 

• Line. When clicked, displays a Line Style dialog so that line 
weight and fill can be applied. 

• Effects. When clicked, a dialog for applying multiple 2D and 3D 
filter effects is displayed. 2D effects include shadows, glow, 
outline, bevel, emboss, colour fill, and feathering. 
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Changing the line style: 

• To adjust the currently selected text's line weight either drag the slider 
left or right or enter a point size value in the input box. 

• For changes to Line fill, click the Line fill swatch to apply a different 
fill (or edit a fill of your own). 

• Uncheck Behind Fill if you want the line fill to show over the top of 
your colour fill rather than behind it. 

Animating text 
Animation brings your text to life, creating titles, captions, or credits of great 
visual appeal. MoviePlus not only offers some familiar animations such as Zoom 
& Fade, Fly, Slide, Spin, and Explode but controls whether the animation is 
applied at the start or end of your text (or both). These are called In Animations 
and Out Animations and are key to understanding how to get the best out of 
your animations. As an example, the Out animation called Explode can be 
applied to the text clip containing the text "Animate". 

 

Animation presets for In and Out animations can be applied from the context 
toolbar, Properties pane or Galleries pane (Text gallery). This saves you from 
having to create your own animation, although you're able to customize any 
presets and save the resulting animation for future use. 

For text clips with multiple text objects: 

• to apply the same animation to all text objects, apply the effect with no 
text objects selected. 
OR 

• to apply independent animations to individual text objects, apply the 
effect with the text object selected. 
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To apply an animation: 

1. Select a text clip (or text object). 

2. Click  Animation on the context toolbar. 

3. From the drop-down list, pick either Set In Animation... or Set Out 
Animation... from the list (for a respective In or Out animation). 

4. From the Choose Animation dialog, choose an animation category 
from the upper window. In the lower window, review the presets 
available for that category (especially their names, which indicate their 
intended function). Select a preset, e.g. Blinds. 
 

 

5. Click OK. 

If you've already applied an In or Out animation, repeat the above procedure to 
apply the complementary Out or In animation, respectively. 

 For an alternative way to apply an animation, open the Galleries 
pane (Text gallery), select a tab in the Animations section, and drag 
a chosen preset onto your text clip (or object). A dialog lets you 
choose whether to add an In or Out animation. 
Hover over any preset to get a preview of how your animation will 
look! 
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Once you've applied animation, you can edit animation properties. As well as 
being able to check which animation is applied (and it settings), you can swap 
out one animation for another, alter its duration, and edit other animation-
specific properties. 

To edit an animation: 

1. Select a text clip (or text object). 

2. From the Properties pane, select the In or Out Animation tab. 

3. Edit the animation settings in the pane. 

To change an animation's duration: 

1. Double-click the text clip. 

2. Drag the left or right-hand end (as shown below) of the animation 
region to extend or reduce it, or specify an absolute Duration value in 
the animation's Properties pane. 
 

 

To save your animation (Timeline only): 

•  From the text clip's Properties pane (In or Out Animation tab), 
click Select, then click Add to Gallery. The animation will appear in 
the relevant tab in the Text gallery. 

To delete an animation: 

1. Select a text clip (or object) with the animation applied. 

2. From the text clip's Properties pane (In or Out Animation tab), select 
Reset for the animation you want to delete. 
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Adding images and QuickShapes 
Images and QuickShapes can be added to your text clips to improve visual appeal. 

 

Once added, you can position, resize, rotate, transform, align, and order the 
image or QuickShape in relation to other objects. (See Manipulating objects on 
p. 162.) 

Adding images 

1. Select your text clip. 

2. From the Video Preview pane, click  Add Image. 

3. From the dialog, locate and select the file to import, the click Open. 
 

 The dialog disappears and the mouse pointer changes to the 
Image Size cursor. What you do next determines the initial size, 
placement, and aspect ratio (proportions) of the image. 

4. Either: 

• To insert the image at a default size, simply click the mouse. 
OR 

• To set the size of the inserted image, drag out a region and release 
the mouse button. 
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Adding QuickShapes 

1. As above, but click  Add QuickShape instead of Add Image. 
 
The QuickShape is drawn unconstrained. 

2. With the QuickShape selected, the Properties pane allows you to: 

• Swap the QuickShape to another QuickShape type, including 
Ellipses, Stars, Spirals, and Speech Bubbles. 

• Morph any QuickShape to create many different shape variations. 

See Using CG Clips (p. 166) for more information. 

Manipulating objects 
The term object refers to any text, image, or QuickShape that you've added to 
your text clip. You'll typically add objects to enhance your titles, but you can add 
additional objects at any time as long as it is to a text clip. 

These objects can be positioned, scaled, rotated, and transformed, as well as 
ordered and aligned—all from within the Video Preview pane. 

 The following examples mainly involve text only, but the principles 
can be applied to text, images and QuickShapes equally. 
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Positioning 
Drag a selected object around the pane into your 
ideal position. 

 

Scaling 
Scale text by dragging a corner handle (this 
maintains aspect ratio). Drag with Shift key 
pressed for unconstrained scaling. By default, 
scaling is made in relation to the opposite corner 
(or edge) handle. 

Instead, to scale from the origin point ( ), use 
the Alt key—drag edge handles to stretch and 
shrink. 

 

Rotating 
Hover over a corner—when the cursor changes to 
a Rotate cursor drag to rotate text. 

 To rotate about a custom origin point, press 
the Ctrl key before dragging to move the origin 
point to a new position. 

 

Shearing 
With the Ctrl key pressed, drag an edge handle to 
shear. 

 

Skew 
Drag a corner handle with the Ctrl key pressed. 
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Ordering (Arranging) 
To order a selected object in relation to other 
objects (by Z-order), right-click the object and 
choose Arrange> then one of the following 
options: 

• Send to Back 
Sends the selected object to the back of 
the Z-order stack, behind all other 
objects. 

• Bring to Front 
Brings the selected object to the front of 
the Z-order stack, in front of all other 
objects. 

• Back One 
Shifts the selected object one position 
toward the rear in the Z-order stack. 

• Forward One 
Shifts the selected object one position 
toward the front in the Z-order stack. 
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Aligning 
To align multiple selected objects in one 
operation and within their selection box, right-
click the selected objects and choose Align>, then 
one of the following options: 

• Left, Right, Top, Bottom: Aligns all 
objects to leftmost object, rightmost 
object, etc. 

• Horizontal Centre/Vertical Centre: 
Aligns all objects to centre of the 
selection area (horizontally or 
vertically). 

To centre object(s) horizontally or vertically in 
relation to their frame width/height, right-click 
on the selected object(s), and choose 
Horizontally or Vertically from the Centre> 
flyout. 
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Using CG clips 
Several types of Computer Generated (CG) clips exist within MoviePlus. They differ 
from video or audio clips in that they are not captured by camcorder, but are 
created from within MoviePlus itself. The following types of CG clip are available: 

• Backgrounds 
To apply simple solid or gradient colours as a clip. Use to introduce 
colour either as part of a fade-in or fade-out or as a background to 
text. Other uses include recolourizing semi-opaque video clips and 
masking shapes or text over a background colour. 
 

 

Solid Fill, Linear Gradient, Elliptical Fill, Conical Fill 

• QuickShapes 
To add modifiable ready-made drawn shapes such as stars, hearts, 
spirals and many more. QuickShapes are great for use in techniques 
such as masking. 
 

 

Star, Heart, Spiral 

What CG clips all share is that they are managed in a very similar way within 
MoviePlus, i.e. they can have colour, transparency and effects applied to them. 
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To apply a CG clip: 

1. In Storyboard mode, select a clip (the clip before which the CG clip 
will be added). 
OR 
On the timeline, position your time indicator on the timeline. 

2. Select your chosen CG clip type from the CG Clip> option on the 
Insert menu. By default, a white background or a QuickShape Ellipse 
is added. 

It's very likely that your CG clip will need to be modified, either to change its 
colour or transparency. For QuickShapes, you'll more than likely want to change 
the QuickShape type. 

 You'll find some ready-to-go sample gradient backgrounds or 
QuickShapes in the Media pane (Library tab), under Samples>Fills or 
Samples>Quickshapes. Simply drag to your storyboard or timeline. 

Adjusting a clip's colour 

MoviePlus offers a number of ways to apply colour to CG clips in MoviePlus. 
You can apply solid or gradient colours to any clip's fill. 

 

Fill 
A new colour is selected from a spectrum of preset colours or 
from a Colour Picker (both accessible via the Fill button on the 
clip's Properties pane).  
 
For gradient fills you can adjust the gradient path of any gradient 
fill and the colours used to make up the gradient (by clicking a 
square node and changing the colour). 
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Adjusting a clip's transparency 

Transparency is great for highlights, shading and shadows, and simulating 
"rendered" realism. It can make a huge difference between your clips looking 
"flat" and appearing with depth and snap. MoviePlus fully supports variable 
transparency and lets you apply solid or gradient transparency to your CG clips. 

 

• Transparency 
Like fills, transparency can be applied from 
the clip's Properties pane. Select the 
Transparency button and choose a 
percentage solid transparency (via slider) or 
pick from a spectrum of preset gradient 
transparencies. If necessary, you can edit the 
transparency path. 

• Solid transparency distributes the 
transparency evenly across the object. 

• Gradient transparencies (Linear, 
Ellipse, and Conical), provide a simple 
gradient effect, with a range from clear 
to opaque. 

Varying the transparency of a CG clip gives the effect of variable erasure, but it 
leaves the original object intact—you can always remove or alter the 
transparency later. Transparencies work rather like fills that use "disappearing 
ink" instead of colour. A gradient transparency varies from more "disappearing" 
to less. 

To save your CG clip: 

• Change the clip's name, then click the  Add to Media pane at the 
top of the clip's Properties pane. The clip will appear in the Media 
pane's Project tab. 
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Fading with backgrounds 

At the beginning or end of your project you can introduce a fade in or fade out 
by using a background clip. Such clips can be editable gradient fills (linear, 
ellipse and conical) as well as solid colours. They can equally be applied between 
clips to act as a coloured interlude (possibly with added captions). 

• On the storyboard, using a fade in as an example, you can introduce a 
background clip before the selected initial clip (Insert>CG 
Clip>Background). 
 

 

• On the timeline, you can do the same but ensure the time indicator is 
set to the start of your project. If the clip you want to fade in to is 
already at the left edge of your timeline, leaving no room for the 
background clip at the beginning of the timeline, you should move 
your video/image clip(s) further down the timeline, creating some 
room at the start of your project. If you've already created a complex 
composition with multiple clips and tracks—so moving the first clip 
would disrupt the rest of your project—MoviePlus can move all of 
your later clips at the same time when a clip is dragged. This automatic 
moving of clips is called Rippling (see MoviePlus Help). 
 

 

 Other timeline fading methods can be carried out using Colour-
Fade or Cross-Fade transitions. 
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More about QuickShapes 

You're more than likely to swap the default Ellipse for a different shape. An 
impressive selection of QuickShape types can be chosen from, and once you've 
picked a type, you can further morph its shape—all from within the 
QuickShape's Properties pane. The ability to further alter the appearance of any 
QuickShape type makes them more flexible and convenient than clipart pictures 
with similar designs. 

 

 

 

 

 

 To change your QuickShape type: 

Once added to your timeline, the QuickShape type can be edited in its Properties 
pane (or by pressing F4). The lower portion of this pane hosts several options 
which will affect your QuickShape's appearance, i.e. 

• Click the QuickShape type drop-down list to swap the default 
QuickShape Ellipse for your preferred shape. 

• The QuickShape preview window updates to show the current 
QuickShape, without colour fills or effect applied. This lets you focus 
on the main purpose of the window—to morph your QuickShape with 
ease.  

 The Stretch to project size checkbox, if checked, will ensure that the 
QuickShape will fully occupy the frame size. 
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To morph your QuickShape design: 

• In the preview window, select a square control handle appearing next 
to the shape. Different QuickShapes have different handles. To find 
out what each handle does for a particular shape, move the control 
handles while reading the Status Bar. 
 

 
 
You can alter shapes dramatically with combinations of control handle 
adjustments. It's best to experiment! 

For example: 

• Dragging the handles of a Petal (above) will alter its inner or outer 
radius, the number of points and the extent to which the points twist. 

• Dragging the top handle on a Polygon will change the number of sides 
to make a triangle, pentagon, hexagon, or other polygon. 

• Dragging the handle on a Rectangle alters the box corners to make 
them more or less rounded. 
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Exporting movies 
There are a number of ways you can export your movie once you've edited it 
with MoviePlus. The project might look fantastic in your Video Preview pane, 
but there's likely to be an upper limit to how many people can crowd around 
your monitor and watch your preview, so you'll need to export your movie in a 
standard distributable format to allow others to share the experience! 

The considerations you'll face when deciding how to export your project are the 
same for all video editors—the most important is "what device will the video be 
watched on and how am I going to deliver the video to the intended viewers?" 
This double-barrelled question, once answered, will help determine how you 
should export your movie for best results. 

To play on: You can: Reference 
computer (with CD) create a Video CD 

(VCD)1 
p. 176 

DVD player (TV) create a DVD1 p. 176 
DVD drive (computer) create a DVD1 

create an AVCHD DVD1 
p. 176 

Blu-ray player (TV) 
Blu-ray drive (computer) 

create a DVD1 
create an AVCHD DVD1 
create a Blu-ray Disc2 

p. 176 

TV (Full HD) (USB or 
memory card) 

standalone file using 
AVCHD Progressive 

p. 186 

iPad2/iPad 
iPod 
iPhone/iPod Touch 

Add to iTunes (for sync 
with Apple device) 

p. 188 

PSP upload to PSP device3 p. 188 
YouTube upload to YouTube4 p. 190 
Facebook upload to Facebook5 p. 192 
Internet standalone file p. 186 
1 Requires DVD Writer/Rewriter or CD Writer. 
2 Requires Blu-ray Writer. 
3 Requires a USB-connected PSP (set to USB mode). 
4 Requires a valid YouTube account. 
5 Requires a valid Facebook account. 
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Exporting movies to disc 
MoviePlus can export your project directly to disc (DVD, Blu-ray Disc, or 
VCD), producing a movie which will play on your TV or computer (via an 
appropriate disc player). 

Optionally, you can create your own easy-to-navigate disc menus based on one 
of an impressive array of templates—all easily modifiable to suit your taste. 

 For DVD/Blu-ray export, Dolby® Digital is used for audio encoding. 

Disc settings 

By default, MoviePlus will suggest the most appropriate export settings for your 
project, although you can alter these settings specifically for export if you have 
custom requirements. For example, PAL DVD and HD project settings are used 
directly for export settings in DVD and Blu-Ray disc creation. 

Several stages make up the disc creation process: 

1. Chapter point set up. If you want a menu on your disc, chapter points 
define locations in your project from which menu chapter thumbnails, 
when clicked, will begin playing the relevant video—much the same as 
the initial menu shown on any movie disc from your local movie store. 
See Using chapter points on p. 94. 

2. Disc Setup. To set up disc settings. Includes Menu Designer, a 
template-driven tool to easily create optional disc menus. 

3. Write Project. To initialize and create the disc. 

The user is led through each stage seamlessly, culminating in the completion of 
your MoviePlus project. 

To create a disc (using project settings): 

1. Select  Export on the Tasks toolbar.  

2. From the drop-down list, choose a disc-related option (DVD, Blu-ray 
Disc, AVCHD, or VCD). 

 The AVCHD option lets you write HD projects to DVD.  
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3. If you haven't already created a disc menu you'll be asked if you want to 
create one. If so, select Yes and the Menu Designer is launched. Otherwise, 
the Export settings dialog is displayed (i.e., your disc will be menuless). 

4. (Optional) From the dialog, choose a different export template from the 
list if needed (i.e. choose PAL or NTSC, and Normal or Widescreen). 
 
Normally, the already selected export setting is chosen by MoviePlus 
as the most appropriate settings and should be kept as is. 

5. Click Next>. 

6. From the Disc Settings dialog, review whether a Disc menu is 
required (check or uncheck as needed), and if necessary click the 
Edit... button to edit your menu in Menu Designer (see p. 178). The 
preview shows your currently selected menu. 

7. (Optional) Check Loop Playback to make your movie start from the 
beginning after playback. 

8. Use the Disc Type drop-down list to check that your project will fit 
intended blank media (e.g., DVD 4.7GB for DVD, BD-RE 25GB for 
Blu-ray Disc). Click Detect... to discover your writable disc drive(s). 
See also Fit to Disc options in MoviePlus Help. 

 For subsequent disc creation, caching technology is used to speed 
up the process. 
 
The Disc Settings dialog also lets you create either an ISO disc image 
or a disc folder (great for viewing disc-related projects without 
writing to disc). For ISO images, you can then write a disc from 
image at a later date (see MoviePlus help). 

9. Click the Finish button. 

10. From the Write Disc dialog, choose a write Speed and Drive where 
your target media is located. Your completed disc will be ejected once 
the process is completed. 



178 Exporting 

 

PAL vs. NTSC video standards 

Whether you choose a PAL or NTSC template should depend on whether you 
intend for the video to be viewed in a PAL region or NTSC region. NTSC is the 
broadcast and recording standard used mainly in North and South American 
continents, plus parts of eastern Asia including Japan and South Korea. PAL is 
used widely throughout Europe, Africa, the Middle East, Asia, and Oceania. 

Using Menu Designer 
The Menu Designer is used for designing a disc menu, a navigational aid to easily 
access key points in your movie called chapters. Its user interface lets you design 
either your own menus from scratch or adopt a professional-looking template 
preset—choose either according to the extent of your design ability! Once your 
menu is complete, you can create your disc directly from Menu Designer. 

The interface can be used to access template galleries, backgrounds, layout options, 
and much more, from a single Menu Bar. When selected, each bar's option offers a 
host of context-sensitive design elements appropriate to that option chosen. 

 

Disc menus are also hierarchical, allowing main titles (e.g., Play Movie) to be 
placed on the top-level menu page, with other menu options (e.g., Scenes) able 
to be placed on a secondary-level page. 
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For movies with multi-page menus, typically for projects with many chapters, all 
pages can adopt the same design or each page can be designed differently. (See 
Creating multi-level menus on p. 184). 

Once the disc is created the menu will display when the disc is loaded, allowing 
easy access to important parts of your movie. When viewing the movie on 
computer, simply navigate via mouse; for TV, use the remote control's 
navigation buttons to jump between disc menu's chapters and pages. 

To launch Menu Designer: 

• Click  Menu Designer on the Tasks toolbar. 

  You can also access Menu Designer during Disc setup, 
accessed via the Export button (pick a disc option). 
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Galleries 

To make life as simple as possible you can adopt one of a series of "themed" 
templates, stored in galleries such as Modern, Seasons, Funky, and Moods, 
amongst many others. 

 
Gallery 

Click the Gallery button to display gallery categories (top) and 
template presets (bottom) on the right-hand side of the dialog. 
Choose a category, navigate the gallery of templates, and click a 
thumbnail to view the design. 

Of particular note is the QuickMovie category, which contains a 
range of template presets specifically designed to complement the 
themes available in QuickMovie Studio. Use these presets to give 
your QuickMovie a consistent look and feel throughout. See 
Creating a themed QuickMovie on p. 32. 

Double-click on "Your Title" text and type your own disc title, then 
either close Menu Designer or, more typically, customize your 
template further. 

Customizing a template 

The Background, Buttons, Layout, Label, Title, and Thumbnail buttons can all 
be used to modify your chosen template. By clicking any one of these options 
along the top bar the user interface refreshes to display an appropriate menu and 
accompanying gallery on the right-hand side of the Menu Designer workspace. 
For example, if you click Title, then a text-related menu will be shown above a 
gallery of title presets. Try it out by clicking on each button on the Menu Bar! 

 

 
 Background 

Click the button to display an upper menu of background 
types above a series of gallery thumbnails for the selected 
menu item. You can choose from a gallery of solid or gradient 
colours, or from a range of artistic background images. 

To use your own custom background, click  Page Setup 
on the toolbar, check Custom Background, then browse to 
and select file that you want to use. 
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 Layout 

Pick an accompanying layout which will house thumbnails for 
all chapters, either on a single or multiple pages. Thumbnails 
are arranged in rows, columns or in more artistic patterns. For 
example, a page layout with eight thumbnails would match 
perfectly with a movie with eight chapters. 

If you choose a layout option with fewer chapter thumbnails 
than the number of chapters in your project you automatically 
create a multi-page disc menu. For example, a "4 Per Page" 
layout would create a two-page disc menu for a MoviePlus 
project with 8 chapters. 

 
Title 

If you want to change the attributes of your current title, click 
this button. 

The gallery will show a range of preset title designs—including 
MoviePlus Styles. These styles are identical to the styles 
available when formatting text clips, which lets you use the 
same style in your disc menu as the ones used on text clips in 
your project! 

If you want to then edit your title, use the menu to change the 
Font, Effects, Colour and Opacity of all your title characters. 

The Menu Designer supports in-place text editing, which 
means direct editing of title text is possible. Either click on the 
title and type to replace the title text or type at an insertion 
point to add more text. You can perform all the common text 
editing functions such as copy (Ctrl+C), paste (Ctrl+V), and 
delete; you can also add a soft carriage return with Ctrl-
Return. 

  
Thumbnail 

Select this button then choose the Frames or Shapes category. 
The latter offers shapes such as Ellipse, Star, Diamond, 
amongst others. Pick a preset from the lower gallery—a whole 
range of thumbnail shapes and styles are available. For shaped 
thumbnails only, change the thumbnail's Border Colour, 
Border Opacity, or apply Effects. 
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Label 

Chapter thumbnail labels can be modified as described above 
for Text. Note that the change affects all labels and not an 
individual label. 

In-place text editing is supported. 

 
 Buttons 

Navigation buttons are used to navigate between multi-page 
disc menus. You can swap out the current buttons, especially if 
a colour clash occurs with your background (preset or 
imported). Click the button to reveal a gallery of buttons. Pick 
a button style, then select your chosen button colour from the 
menu above the button gallery. 

 
Apply to All 

For multi-page menus, changes are made across all pages by 
default. If the button is disabled, changes are made to the 
current page only. 

 
 Preview 

Click this button to view how your project will look on your 
TV without the need to create a disc. Preview, adjust your 
menu design, then preview again until your menu is to your 
satisfaction. Use the accompanying buttons to simulate your 
DVD player's remote control for testing purposes. 

Editing chapter properties 

When you launch Menu Designer, you'll see either: 

• A single thumbnail called "Play" appear in your menu workspace. This 
occurs if you haven't inserted chapter points on your timeline. 
OR 

• If you have inserted chapter points onto your storyboard or timeline 
(as part of video editing), a series of thumbnails are shown which 
represent the chapter at which you added a chapter point. 

Once chapters are present, their properties can be edited or viewed, i.e. you can: 

• Preview the content of each chapter by playback. 

• Zoom in/out of individual frames to inspect the chapter. 
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• Swap to a different thumbnail, taken directly from any frame within 
the chapter, e.g. a frame which typifies a chapter much more than any 
other. 

• Change the chapter name, i.e. the label shown next to the thumbnail. 

To view chapters: 

• Double-click a chapter thumbnail in the menu workspace. 

In the Button Properties dialog, the video frames displayed for a chapter are 
those spanning between the selected and the next chapter point on the timeline 
(if no chapter point exists after the current one the remainder of the movie is 
shown). 

The available navigation controls assist with the inspection, viewing and editing 
of the chapter. 

To use a different frame as thumbnail: 

•  In the Button Properties dialog, use the navigation controls to 
navigate then pick the right frame. Once you're happy with the 
thumbnail shown in the preview window, click the Jump to Caret 
button (this aligns the red Image indicator under the time indicator 
position). On exit, this thumbnail will now be shown to represent your 
chapter. 
OR 

• Drag the red indicator, which realigns then synchronizes the time 
indicator to it. This automatic alignment provides a simple method for 
alternative thumbnail selection (avoiding the Jump to Caret 
operation). 

 Changing the thumbnail picture does not affect the chapter point 
positions on the timeline. However, moving chapter points on the 
timeline will reposition your modified thumbnail, so remember to 
always check thumbnails are correctly set. 
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To rename your chapter: 

• In the Button Properties dialog, enter a new Name (or edit the existing 
name). 

Creating multi-level menus 

In advance of entering Menu Designer, your chapter points need to be defined 
for your project. If you want to create multi-level menus, chapter points for your 
top-level menu have to be additionally set as "Top Level" chapter points. This is 
done from the General tab, on the Properties pane, when your chapter point is 
selected—simply select the Top Level option, adding your own text if required. 

All other chapter points without this option enabled are automatically relegated 
to lower-level menus. 

For more information about chapter points, see Using chapter points on p. 94. 

Setting background music 

By default, no background music is played when your disc menu is displayed on 
your target device. However, it's often a nice finishing touch to complement 
your menu design with supporting audio—use it for instructional reasons or to 
simply play background music. The audio stream of a video file can also be used 
as background music. 

 If you've used a background video on your menu, you can use its 
audio as a page soundtrack. The same music can be applied to all 
pages or you can apply different music to the current page only 
using options in the Page Setup dialog. Enable Apply changes to 
this page only or Apply changes to all pages to make the music play 
just on the current page or across all pages. 
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To enable background music: 

1. Click the  Page Setup button on the Menu Bar. 

2. From the dialog, pick an option from the Music section. Either: 

• For music from a saved audio or video file: 
Click the second radio button, and either type the path to the 

media file or click the  Browse button to navigate to the file. 
For the latter, navigate and select a media file (video file must 
contain audio) from the dialog. Common Audio files such as 
MP3, WAV, and WMA are supported, as well as video files such 
as AVI, MPG, MOV, WMV and ASF. 
OR 

• For music from the page's background video: 
Enable the Use soundtrack from background video button. You 
must have previously set a video as the Custom Background from 
the same dialog. 

3. Click OK. 

Animating your menu 

If your menu needs some extra visual appeal it's possible to animate your menu 
thumbnails or background, or both. This will automatically play movie chapters 
within their thumbnail preview, or play any currently configured video 
background. 

To animate thumbnails and/or video backgrounds: 

• In  Page Setup, check either Animate Thumbnails or Animate 
Background, or both. A slider sets the time the thumbnails or 
background will animate for before the animation loops and plays 
again. 
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Closing Menu Designer 

•  Choose Exit Menu Designer in the Options menu or click 
the Close button. You will be prompted to save your project if it is 
currently unsaved. Your updated template will be shown by default the 
next time you load the Menu Designer. 

  If you accessed Menu Designer directly from the Tasks 
toolbar, the Menu Bar will also host a Write Project button. This 
displays a drop-down menu with options for writing to Blu-ray discs, 
AVCHD discs, DVDs, and VCDs directly from the Menu Designer. 

Exporting as a file 
MoviePlus can export your project to one of several commonly encountered 
video file formats. 

 

In most instances, you would export your file as an MP4 Video (*.mp4), unless 
there is a specific reason for choosing a different export option. The MP4 format 
is a modern compressed streaming format (utilizing the H.264 video codec), 
ideal for Internet use and storage on both local and portable devices. 

To export as a file: 

1. Select  Export on the Tasks toolbar.  

2. From the drop-down list, choose File. 
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3. Select your chosen file type from the list according to intended use, 
then click Next>. 

4. From the Export Settings dialog, several options are available: 

• (Optional) Select a preset export template. Click Customize... to 
create your own export template if necessary. 

• (Optional) Change Render Quality (between Draft and Best 
quality) to control the level of video and audio processing carried 
out during export. 

• (Optional; timeline mode only) If you're exporting just part of 
your project, the Export selected range option can be checked to 
limit the export; you need to place selection markers on your 
timeline first. 

• Click Finish. 

5. To save the file, locate a target folder and specify a name for your file 
in the File name box, then click the Save button. Your project will 
then be composed and converted into the specified format and you 
will be shown a progress bar during this process. 

6. On completion, the file can be opened with the Open button (to play 
the resulting video in your default media player software), you can 
explore the file's folder with Open Folder or just Close the dialog and 
return to MoviePlus. 

 You can click Cancel to abort the export process (you'll be 
prompted to confirm this in case of an accidental key press and be 
offered to delete the file). 

Creating Progressive AVCHD files for Full HD TVs 

If you have AVCHD Progressive video clips (from your AVCHD Progressive 
camcorder), you can share them on a Full HD TV by exporting the project as 
MPEG Video (using the AVCHD Progressive export setting; PAL or NTSC). 
This creates a M2TS file that you can then make available to your TV (e.g., via 
USB, SD Card, etc). 
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Exporting to iTunes/PSP 
MoviePlus allows you to share your finished movie via Apple devices 
(iPad/iPad2, iPhone4/4S, and video-capable iPod devices). By exporting directly 
to iTunes you'll be able to include your movie in your iTunes library; simply 
sync up to your Apple device and your movie is ready to be shared. 

You'll also be able to upload your movie to Sony PSP devices. 

Export to iTunes 

Exporting your movie to video-capable Apple devices is carried out in two 
stages—exporting the movie automatically to iTunes and subsequently syncing 
the movie to your Apple device. MoviePlus takes care of the first stage, but you'll 
need to sync your movie to your device as you would for any other movie file. 

To export to iTunes: 

1. Select  Export on the Tasks toolbar.  

2. From the drop-down list, choose iTunes/PSP. 

3. From the dialog, a suitable export setting will be offered that best 
matches your current project settings. A default device is selected 
automatically, but you may need to select a setting that matches your 
own device from the menu. 
 
You can also change your video standard from PAL to NTSC (or vice 
versa) by using a different parent menu, and then choose equivalent 
options.  
 
The export settings offer a native setting (e.g., iPad 2 - Native PAL) 
and alternative options for various frame size and bit rates. 

4. (Optional) You can click Customize... to create and use your own 
export template if needed. 

5. Change Render quality—set Draft when testing and Best for final, 
high quality. 
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6. If you're exporting just part of your project, the Export selected range 
option can be checked; you'll need to place selection markers on your 
timeline first. See Using selection markers on p. 96. 

7. Click Finish. 

8. From the Save As dialog, locate a target folder and specify a name for 
your mp4 video file in the File name box, then click the Save button. 
Your project will then be composed and converted into the specified 
format; you will be shown a progress bar during this process. 

 You can click Cancel to abort the export process (you'll be 
prompted to confirm this in case of an accidental key press and be 
offered to delete the file). 

On completion, the file can be opened with the Open button (to play 
the resulting video in your default media player software) or you can 
explore the file's folder with Open Folder (or just Close the dialog and 
return to MoviePlus). 

9. Click Continue to launch iTunes automatically. Your movie will 
already be added to your iTunes library (under Films). 

The next time you connect your Apple device, it will sync up to your iTunes 
library, copying your movie to your device. 

Export via PSP 

If you own a Sony PSP, you can export your movie easily. In USB mode, your 
PSP is seen as any other removable storage device—as such your movie is 
uploaded onto the device with the minimum of fuss. 

 To upload, your PSP must be in USB mode. 
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To export to PSP: 

1. As for exporting via iTunes (above) but instead of choosing an Apple 
device export template, choose a PSP-specific template from the list. 
Click Next>. 

2. From the Upload to PSP dialog, enter a Movie title and select the PSP 
device from the drop-down menu. This should show the PSP as a 
removable storage device. 
 

 

3. (Optional) Check Keep a local copy... to save the exported movie for 
use again (leads to quicker exports for unchanged projects). 

4. Click Finish. The project will then be composed and converted into 
the specified format and you will be shown a progress bar during this 
process. 

 You can click Cancel to abort the export process (you'll be 
prompted to confirm this in case of an accidental key press and be 
offered to delete the file). 

5. Click Continue to upload the local movie up to the PSP. 

Exporting to YouTube 
Placing a movie on YouTube means that you can share a short movie worldwide 
without writing to media or uploading to your own web site. The two-stage 
process involves exporting a file optimized for upload (i.e., wmv) then uploading 
the file to the YouTube website. 

 A working YouTube (or Google) login is required to upload your 
movie to YouTube. If you don't have a login, visit www.youtube.com 
and register! 
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To export to YouTube: 

1. Select  Export on the Tasks toolbar.  

2. From the drop-down list, choose YouTube. 

3. From the dialog, select a YouTube export setting from the list. This 
will be automatically selected to match your project settings so you 
won't normally need to change this. 
 
However, you can choose a separate export setting from the list if 
needed, or click Customize... to create your own export template. 

4. (Optional) Change Render quality—set Draft when testing and Best 
for final, high quality. 

5. (Optional) If you're exporting just part of your project, the Export 
selected range option can be checked; you'll need to place selection 
markers on your timeline first. See Using selection markers on p. 96. 

6. Click Next>. 

7. From the Save As dialog, locate a target folder and specify a name for 
your wmv video file in the File name box, then click the Save button. 
Your project will then be composed and converted into the specified 
format and you will be shown a progress bar during this process. 

 You can click Cancel to abort the export process (you'll be 
prompted to confirm this in case of an accidental key press and be 
offered to delete the file). 

8. (Optional) On completion, the file can be opened with the Open 
button to check before YouTube upload (this plays your video in your 
default media player software) or you can explore the file's folder with 
Open Folder. 

9. Click Continue to launch the YouTube Upload dialog. Add your 
YouTube login details (UserID and Password), movie Title and 
Description, a YouTube Video Category, and some keywords (Tags) 
for users to search for.  
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Instead, you can upload by using valid Google account details (but 
you'll still need a valid YouTube UserID also). 

10. Click Finish to begin the file upload. A progress bar is shown during 
upload. 

 You'll get a warning if the exported movie's duration (or file size) 
exceeds a configurable limit (set in Tools>Options>Export). You'll 
still be able to continue upload if you wish. 

Exporting to Facebook 
MoviePlus lets you share your completed movie on the Facebook social 
networking site. If you're already signed up to Facebook you can have your 
movie uploaded directly onto your Facebook wall. If not, you can sign up to 
Facebook during the upload progress. 

To export to Facebook: 

1. Select  Export on the Tasks toolbar.  

2. From the drop-down list, select Facebook. 
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3. From the dialog, select a Facebook export setting from the list. This 
will be automatically selected to match your project settings so you 
won't normally need to change this. 
 
However, you can choose a separate export setting from the list if 
needed, or click Customize... to create your own export template. 

4. (Optional) Change Render quality—set Draft when testing and Best 
for final, high quality. 

5. (Optional) If you're exporting just part of your project, the Export 
selected range option can be checked; you'll need to place selection 
markers on your timeline first. See Using selection markers on p. 96. 

6. Click Next>. 

7. From the Save As dialog, locate a target folder and specify a name for 
your file in the File name box, then click the Save button. Your project 
will then be composed and converted into the specified format and 
you will be shown a progress bar during this process. 

 You can click Cancel to abort the export process (you'll be 
prompted to confirm this in case of an accidental key press and be 
offered to delete the file). 

8. (Optional) On completion, the file can be opened with the Open 
button to check before upload (this plays your video in your default 
media player software) or you can explore the file's folder with Open 
Folder. 

9. Click Continue. 

10. From the Facebook Upload dialog, enter your movie Title and an 
optional Description. This text will show next to your movie in 
Facebook. Click Next>. 
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11. From the Facebook login dialog, enter your login details and click 
Login. 
 

 
 
At login, check Keep me logged in to avoid logging in every time you 
export to Facebook! 

12. From the Facebook upload dialog, click Finish. Your movie is 
uploaded. 

13. Click Finish. 

The progress bar indicates the status of the export and upload processes. When 
the upload is complete, it closes automatically. Your video will appear on your 
Facebook wall. 

 If you've previously logged into Facebook (or via a web browser) the 
Facebook login dialog is not displayed. 

 You'll get a warning if the exported movie's duration (or file size) 
exceeds a configurable limit (set in Tools>Options>Export). You'll 
still be able to continue upload if you wish. 
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Converting video files 
While it's possible to add video clips to your storyboard or timeline and then 
export to file, if you're looking to convert video files to a different video file 
format you can use the Convert Video Files feature (Tools menu). 

As an example, you may want to convert various file formats to the compressed 
MP4 format for upload to the web. 

To convert a file:  

1. From the Startup Wizard (or Tools menu), select Convert Video 
Files....  

2. From the dialog, click  Import Media to add video files by one of 
two methods: 

• Import - To navigate to and import media files from your local 
hard disk, network drive, or disc. 

• Copy from Device - To copy files from a camcorder's hard disk, 
internal DVD, or flash card. 

Repeat to add further media files from different locations. 

3. For an Output Format, click Change... to select an export file type 
(e.g., MP4) and a "target" export setting (e.g., iPad 2 - Native PAL) 
from respective dialogs. 

4. For an Output Folder, select the Browse... button to locate and select 
the target folder. 

5. Click Convert Files. 

The Video File Converter Tasks dialog shows your previously selected files 
being converted in the Pending Tasks box. Once converted, the files are added 
to the lower Converted Files box. 

Converted files require some form of action by the user. Three options are 
available via buttons under the Converted Files box. 
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• Open Containing Folder - Click to take you straight to the Output 
folder defined previously. Use this option if you want to upload the file 
independently of MoviePlus.  

• Add To Media Pane - Click to add the converted file to MoviePlus's 
Media pane, in readiness for editing in your project. 

• Clear List - Click to remove your converted files from the list. 

 Click Continue in background to close the dialog and make 
currently pending tasks be background tasks.  

When you're converting files, a progress bar appears on the Status bar while the 
file is being converted.  

 Cancel lets you abort file conversion, while  File converter lets you 
quickly access the File converter dialog to view your files being converted. The 
latter button will always show when you've converted files but still need to add 
the files to the Media Pane.  
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Performance Notes 

Improving playback performance 

For non-HD projects, you may not experience any playback problems during 
preview. However for more complex projects, i.e. those using a myriad of special 
effects or transitions on multiple tracks, or HD projects you may encounter 
stuttering playback. Several options can be used to alleviate this: 

• Dropping the Render Quality during preview 

• Pre-rendering (a clip, transition, or time range)  

• Creating proxy files (if using HD video)  

You can adopt a combination of these methods to suit your project. 

Render quality 

The Render Quality options on the Preview menu (or right-click on the Video 
Preview pane) determines at what quality your movie will be previewed and will 
determine how hard MoviePlus will work to draw (render) your movie. Quality 
options range from Draft to Best—if you are experiencing stuttering playback, 
especially where transitions or effects are in progress, you can reduce the 
preview quality to improve playback speed without harming your project. 
Render Quality has no effect on your export quality, which is controlled 
separately. 

  You can also improve playback performance, by reducing the 
size of your preview (zoom out) by clicking the Zoom Out button (or 
via the same option on the Preview menu). 

Pre-rendering 

Pre-rendering can be enabled in advance of video preview to improve playback 
performance, especially when displaying transitions, effects, blending, and text. 
It can take place in several ways—either for your entire project, for specific clips, 
on one or more multiple transitions, or over a set time range. 



200 Appendix 

 

When you drag clips onto your timeline, you'll see red pre-render indicator bars 
(arrowed) above your timeline ruler to show areas which are suggested for pre-
rendering (in the example below, transitions between clips are suggested for pre-
rendering). 

 

Once you've pre-rendered your project (discussed later), these red bars will 
change to green bars. 

 If pre-rendering is in progress, the indicator bars for the portion of 
your project currently being pre-rendered shows temporarily in 
orange. 

 Pre-rendering is a background task, which allows you to get on with 
your project development. The process actually creates preview files 
which can be managed and deleted via a Background Task 
Manager. 

  A green progress bar on the Status Bar indicates pre-rendering 
progress. Pre-rendering may take some time to complete for larger 
files. If needed, you can click the Cancel button on the bar to abort 
the process. 

To pre-render your entire project: 

• Right-click the Video Preview pane and select Pre-render All. 

The Status Bar indicates pre-rendering of your project. Once complete, pre-
rendering will have changed any red indicator bars to green. 
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As you further develop your project—changing transitions, adding clip effects, 
adding text clips, performing video blending—you'll see red indicator bars again. 
Don't panic! You just need to pre-render your project again! 

MoviePlus also lets you pre-render complex project areas or parts of your 
project (if you've got a particular reason to do so). See MoviePlus Help. 

Using Proxy files 

A proxy file in MoviePlus is a reduced-resolution file which is written to assist in 
the playback of your HD video clip, therefore optimizing the program's playback 
performance. Otherwise, previewing a HD video clip will put extra demands on 
your computer's processor due to its high resolution characteristics, resulting in 
stuttering playback. 

Proxy files are created by default when you drag HD media onto your 
timeline/storyboard. You'll see a progress bar on the Status Bar showing each 
proxy file being created for each HD video clip in turn. 

For computers with quad-core processors, previewing HD video smoothly is a 
reality. As a result, proxy file generation in MoviePlus when using such 
computers is disabled by default. For some higher performance computers, you 
may not need to proxy your HD video files as your computer may be sufficiently 
powerful to preview acceptably. This can be disabled from Tools>Options... if 
needed. 

To switch off proxy files automatically: 

1. Select Options... from the Tools menu. 

2. From the Proxy Files menu option, uncheck Use proxy files for HD 
video. 

 You can always temporarily check how the original file plays back at 
any time by right-clicking your file and unchecking the Use Proxy 
File option prior to previewing. 

Instead of creating proxy files automatically, you can create proxy files for 
specific HD video files directly on the timeline. 
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To create a proxy file for a single HD video clip: 

• Right-click on the HD video clip (Timeline only), and select Use 
Proxy File. 

 You have the option of creating proxy files in the Media pane before 
committing HD video clips to the timeline/storyboard. Right-click a 
clip and choose Create Proxy File. This avoids having to generate 
lots of proxy files sequentially as you add HD video clips to the 
timeline. 
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Keyboard Shortcuts 

 These published shortcuts are the program default shortcuts. 
However, it is possible to customize these to fit your own 
requirements, invalidating this topic. 

Single-letter keys Description 

G Group 

I Set Start Time 

M Mute 

O Set End Time 

S Split 

 

Control Keys Description 

Ctrl+Shift+C Copy Frame in Preview 

Ctrl+Shift+F Autofit 

Ctrl+Shift+G Ungroup All 

Ctrl+Shift+Left Go to Previous Marker 

Ctrl+Shift+Right Go to Next Marker 

Ctrl+Left arrow Moves track out of group (Timeline mode) 

Ctrl+Right arrow Moves track into group (Timeline mode) 

Ctrl+Up arrow Move track or group up the stack (Timeline mode) 

Ctrl+Down arrow 
Move track or group down the stack (Timeline 
mode) 

Ctrl++ Zoom in to timeline 
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Ctrl+- Zoom out of timeline 

Ctrl+[ Zoom to all (timeline) 

Ctrl+] Zoom to Selection (timeline) 

Ctrl+< Select Previous Keyframe 

Ctrl+> Select Next Keyframe 

Ctrl+\ Switch to Timeline\Storyboard mode 

Ctrl+A Select Related Objects 

Ctrl+C Copy 

Ctrl+H Help File Manager 

Ctrl+Delete Delete Selection Only 

Ctrl+Enter Pre-render Selected Range 

Ctrl+Home Scroll to Time indicator (Timeline and Storyboard) 

Ctrl+M Go to Marker (or chapter point). 

Ctrl+N New MoviePlus Project 

Ctrl+O Open MoviePlus Project 

Ctrl+P MoviePlus Project Settings 

Ctrl+S Save MoviePlus Project 

Ctrl+T Background Task Manager 

Ctrl+V Paste 

Ctrl+X Cut 
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Ctrl+Y Redo 

Ctrl+Z Undo 

Ctrl+0 Zoom Preview to 100% 

Ctrl+1 Draft Render Quality 

Ctrl+2 Preview Render Quality 

Ctrl+3 Normal Render Quality 

Ctrl+4 Good Render Quality 

Ctrl+5 High Render Quality 

Ctrl+6 Best Render Quality 

  

Misc keys Description 

Del Delete 

End Go to end of movie 

Enter Pre-render All 

Esc Stop the movie (and return to start of playback) 

Home Go to start of movie 

Left Go to Previous Frame 

Right Go to Next Frame 

Space Play/Pause the movie 
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Function Keys Description 

F1 Help 

F2 Play/Pause the movie 

F3 Media pane 

F4 Properties pane 

F5 Galleries pane 

F6 Inserts a marker 

F7 Inserts a Video Effect 

F8 Inserts a Video Effect Group (Timeline mode) 

F9 Inserts a Video Track (Timeline mode) 

F10 Inserts an Audio Track (Timeline mode) 

F11 Inserts a Video Group (Timeline mode) 

F12 Inserts an Audio Bus (Timeline mode) 

Shift+F6 Inserts a chapter point 

  

Shift Keys Description 

Shift+F Align to Frames 

Shift+G Ungroup 

Shift+L Linking (Timeline mode) 

Shift+P Move time indicator to end of clip when pasting 

Shift+R Rippling 

Shift+S Snapping 

Shift+Left 
Go to Previous Clip (or to previous split in Trim 
dialog) 

Shift+Right Go to Next Clip (or to next split in Trim dialog) 
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Contacting Serif 

Contacting Serif Support 

Our support mission is to provide fast, friendly technical advice and support 
from a team of on-call experts. 

Serif Support on the web 

Serif Support 
website 

www.support.serif.com 

 Twitter twitter.com/serifsupport 

 Facebook www.facebook.com/SerifSupport 

Additional Serif information 

Serif on the web 

Serif website www.serif.com 

Forums www.serif.com/forums.asp 

 

youtube.com/serifsoftware 

 

Main office (UK, Europe) 

Address The Software Centre, PO Box 2000 
Nottingham, NG11 7GW, UK 

Phone (0115) 914 2000 

Phone 
(Registration) 

(0800) 376 1989 
+44 800 376 1989 

Phone 
(Sales) 

(0800) 376 7070 
+44 800 376 7070 

Fax (0115) 914 2020 

http://www.support.serif.com/
http://twitter.com/#!/serifsupport
http://www.facebook.com/SerifSupport
http://www.serif.com/
http://www.serif.com/forums.asp
http://www.youtube.com/serifsoftware
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North American office (US, Canada) 

Address Serif Inc., The Software Center 
4041 MacArthur Blvd., Suite 120 
Newport Beach, CA 92660, USA 

Phone  
(Registration) 

800-794-6876 

Phone 
 (Sales) 

800-489-6703 

Phone  
(Customer Service) 

800-489-6720 

For international enquiries, please contact our main office. 
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Credits 
This User Guide, and the software described in it, is furnished under an end user License 
Agreement, which is included with the product. The agreement specifies the permitted and 
prohibited uses. 

Trademarks 
Serif is a registered trademark of Serif (Europe) Ltd. 

MoviePlus is a registered trademark of Serif (Europe) Ltd. 

All Serif product names are trademarks of Serif (Europe) Ltd. 

HDV and the HDV logo are trademarks of Sony Corporation and Victor Company of 
Japan, Ltd. 

Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft 
Corporation. All other trademarks acknowledged. 

PrimoSDK and Px Engine are trademarks of Sonic Solutions. All other trademarks are the 
property of their respective owners. 

Blu-ray Disc and Blu-ray, and the logos are trademarks of the Blu-ray Disc Association. 

AVCHD and the AVCHD logo are trademarks of Panasonic Corporation and Sony 
Corporation. 

VST is a trademark of Steinberg Media Technologies GmbH. 

Windows Vista and the Windows Vista Start button are trademarks or registered 
trademarks of Microsoft Corporation in the United States and/or other countries. 

QuickTime is a trademark of Apple Computer, Inc., registered in the U.S. and other 
countries. 
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Copyrights 
Digital Images ©2008 Hemera Technologies Inc. All Rights Reserved. 

Digital Images ©2008 Jupiterimages Corporation, All Rights Reserved. 

Digital Images ©2008 Jupiterimages France SAS, All Rights Reserved. 

Content ©2008 Jupiterimages Corporation. All Rights Reserved. 

This application was developed using LEADTOOLS, copyright © 1991-2007 LEAD 
Technologies, Inc. ALL Rights Reserved. 

Portions MPEG encoding technology © 1999/2000-2003 MainConcept AG. 

Portions digital audio content © 2003-2005 Robert Bailey 
(http://www.a1freesoundeffects.com). 

Animations © 2003-2010 Suite Imagery LLC. All rights reserved. 

Facebook © 2008 Facebook Inc. 

© 2004 Sonic Solutions. Sonic and the Powered by Sonic logo are trademarks or registered 
trademarks of Sonic Solutions in the U.S. and/or other countries. 

Manufactured under license from Dolby Laboratories. Dolby and the double-D symbol are 
trademarks of Dolby Laboratories. Confidential unpublished works. Copyright 1992–1997 
Dolby Laboratories. All rights reserved. 

© 2012 Serif (Europe) Ltd. All Rights Reserved. No part of this User Guide may be 
reproduced in any form without the express written permission of Serif (Europe) Ltd. 

Serif MoviePlus X6 © 2012 Serif (Europe) Ltd. All Rights Reserved. 

Companies and names used in samples are fictitious. 
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2D 
filter effects, 120 
transforms, 105 

3D 
filter effects, 122 
transforms, 105 

adjustments (audio), 39 
applying, 39 
changing, over time, 86 
pan, 39, 141 
volume, 39, 140 

adjustments (video), 39 
applying, 39 
changing, over time, 86 
Colour, 39 
Crop, 39, 41 
Lighting, 39 
Noise reduction, 39 
Opacity, 39, 97 
Stabilize, 39 
Transform, 39, 105 

Android phones (export), 186 
animation (text), 158 
Apple devices (export), 188 
audio, 131 

adding, 132 
adjusting pan in, 141 
adjusting volume in, 140 
bus, 137 

assigning audio track to, 138 
creating, 138 

clips, 132 
editing, 132 

fading, 136 
levels, 139 
mixing, 80, 87 
muting, 136 
pan, 139 
ripping, 144 
track, 63 
volume, 139 
waveform display, 134 

audio effects, 124 
adding, 125 
modifying, 126 
VST, 127 

AVCHD, 176 
Progressive, 187 

background clips (CG), 169 
Background Task Manager, 200 
backgrounds, 99, 103 

removing, 99 
blue/green screening, 103 
Blu-ray disc (writing), 176 

Menu Designer for, 178 
bus (audio). See audio bus 
captions, 151 
Capture, 18, 22 
CD (audio) 

ripping, 144 
CG clips, 166 

background, 169 
QuickShapes, 170 

chapter points, 182 
on storyboard, 50 
on timeline, 94 
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Chroma Key, 103 
clip groups, 77 
clipping (audio), 140 
clips 

arranging, 53, 70 
audio, 132 
background, 169 
Computer Generated (CG), 166 
linking (timeline), 72 
overlap control of, 85 
QuickShape, 170 
resizing, 45 
selecting, 53, 67 
splitting, 80 
text, 149 

default, 154 
trimming, 24 
video/audio, 62 

colour, 123 
correcting, 123 
fade to a, 169 

Colour (adjustment), 39 
changing, over time, 86 

Computer Generated (CG) clips, 
156, 166 

contacting Serif, 207 
converting video files, 18, 195 
Copy from Device, 17, 22 
credits, 152 
Crop (adjustment), 39, 41 

changing, over time, 86 
cropping, 41 
custom projects, 21 
cutouts, 99 
 

DVDs (writing), 176 
from AVCHD, 176 
Menu Designer for, 178 

effect groups, 80 
effects 

2D filter, 120 
3D filter, 122 
audio, 124 

VST, 127 
changing, over time, 86 
video, 115 

exporting, 175 
as file, 186 
to Blu-ray, 176 
to disc, 176 
to DVD, 176 
to Facebook, 192 
to iTunes/PSP, 188 
to YouTube, 190 

Facebook (export), 192 
fading, 81, 169 

in audio, 136 
to/from black 

on storyboard, 54 
on timeline, 169 

with transitions, 54, 81 
features 

key, 4 
new, 10 
unlocking, 12 

filter effects, 120, 122 
full screen preview, 31 
green/blue screening, 103 
 
 



Index 215

 

groups 
applying effects to, 80 
clip, 74 
master, 79 
video, 77 

HD video 
proxy files for, 201 

images 
on text clips, 161 

manipulating, 162 
Import (media), 17, 22 
installation, 12 
iPad2/iPad/iPod/iPhone (export), 

188 
iTunes, 188 
Ken Burns effect, 43 
key features, 4 
keyboard shortcuts, 203 
keyframe strips, 87 

showing, 88 
keyframes, 87 

deleting, 90 
modifying, 90 
moving, 91 
navigating, 91 
selecting, 89 

levels (audio), 139 
Levels meter, 139 
Lighting (adjustment), 39 

changing, over time, 86 
link overlays, 74 
linking, 72 
M2TS/M2T (export), 186 
 
 

markers, 92 
adding, 93 
chapter points as, 94 
navigating, 93 
selection, 96 

masking 
changing, over time, 86 

masks, 99 
master groups, 79 
matting, 103 
media 

adding to project, 22 
adding to storyboard, 51 
adding to timeline, 65 
importing, downloading, and 

capturing, 22 
rotating, 23 

Media Pane, 23 
Menu Designer (for discs), 178 

chapter points for, 182 
meter (audio levels), 139 
mixing 

audio, 80 
mono (audio), 131 
MP4 (export), 186 
MPEG 

exporting, 186 
multi-trimming, 26 
muting 

audio, 136 
video, 64 

narration, 141 
recording, 142 

new features, 10 
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Noise Reduction (adjustment), 39 
NTSC, 19, 178 
objects, 161 

image, 161 
manipulating, 162 
QuickShape, 162 
text, 149 

opacity, 97 
Opacity (adjustment), 39 

changing, over time, 86 
optimizing performance, 199 
overlaps, 85 
Overlay Track, 107, 149 
overlays, 107 

link, 74 
PAL, 19, 178 
pan, 139 
Pan (adjustment), 39, 141 

changing, over time, 86 
pan and zoom (video), 43 
performance (playback), 199 
perspective 

changing, over time, 86 
picture-in-picture effects, 86 
playback (improving), 32, 199 
pre-rendering, 199 
preview 

full screen, 31 
project 

opening, 17, 21 
settings, 20 

custom, 21 
starting a new, 18 

proxy files (for HD video), 201 
PSP (export), 188 

QuickMovies, 17, 32 
disc menus for, 180 

QuickShapes, 162, 166 
on text clips, 162 

manipulating, 162 
QuickTime (export), 186 
registration, 3 
render quality, 199 
resizing clips, 45 
ripping audio CDs, 22, 144 
rippling, 76 
rotating (media files), 23 
scrolling (timeline), 69 
scrubbing (timeline), 70 
seeking (timeline), 68 
Serif (contacting), 207 
shapes, 166 

on text clips, 162 
shortcuts (keyboard), 203 
slipping (in trimming), 26 
slow motion, 97 
snapping, 77 
speeding up, 97 
splitting, 26 

on timeline, 80 
Stabilize (adjustment), 39 
Start New Project, 17 
Startup Wizard, 17 
storyboard, 49 

adding media to, 51 
arranging clips on, 53 
basics, 49 
fading in/out on, 54 
resizing clips on, 45 
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selecting clips on, 53 
time indicator, 50 

stretching, 97 
system requirements, 12 
templates (text), 154 
text, 149 

adding, 149 
animating, 158 
clip, 149 

templates, 154 
editing, 155, 156 
formatting, 156 
manipulating, 162 
objects, 153 
selecting, 155 

themed QuickMovies, 32 
disc menus for, 180 

timeline, 59 
adding media to, 65 
arranging clips on, 70 
basics, 59 
chapter point, 61 
counter, 61 
groups, 63 
keyframes, 62 

strip, 62 
markers, 61 
mute indicator, 64 
overlays, 63 
ruler, 61 
scrolling the, 69 
scrubbing the, 70 
selecting clips on, 67 
time indicator, 61 
 

tracks, 63 
transitions, 62 
Visual Reference, 60 
zooming the, 68 

titles, 150 
tracks 

adding and arranging, 64 
timeline, 63 

Transform (adjustment), 39 
changing, over time, 86 

transforms, 105 
transitions 

changing, over time, 86 
storyboard, 54 
timeline, 81 

transparency, 97 
trick play, 29 
trimming, 24 

multi-, 26 
unlock codes, 12 
VCD writing, 176 
video 

adding clips, 22 
adding tracks, 64 
converting, 195 
groups, 74 
previewing, 28 
splitting, 80 

video effects, 115 
adding, 117 

video groups, 77 
Video Preview Pane, 28 
Video Standards 

PAL/NTSC, 19, 178 
Vimeo (export), 186 
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Visual Reference 
storyboard, 49 
timeline, 60 

voice-overs, 141 
volume, 139 
Volume (adjustment), 39, 140 

changing, over time, 86 
VST audio effects, 127 

waveform display (audio), 134 
Welcome, 3 
What's new, 10 
WMV (export), 186 
YouTube (export), 190 
zoom and pan (video), 43 
zooming (timeline), 68 
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